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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface  
 

SINUMERIK documentation 
The SINUMERIK documentation is organized in the following categories: 

● General documentation 

● User documentation 

● Manufacturer/service documentation 

Additional information 
You can find information on the following topics at www.siemens.com/motioncontrol/docu: 

● Ordering documentation/overview of documentation 

● Additional links to download documents 

● Using documentation online (find and search in manuals/information) 

Please send any questions about the technical documentation (e.g. suggestions for 
improvement, corrections) to the following address:  

docu.motioncontrol@siemens.com 

My Documentation Manager (MDM) 
Under the following link you will find information to individually compile OEM-specific 
machine documentation based on the Siemens content:  

www.siemens.com/mdm  

Training  
For information about the range of training courses, refer under: 

● www.siemens.com/sitrain 

SITRAIN - Siemens training for products, systems and solutions in automation technology 

● www.siemens.com/sinutrain 

SinuTrain - training software for SINUMERIK 

FAQs 
You can find Frequently Asked Questions in the Service&Support pages under Product 
Support. http://support.automation.siemens.com 
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SINUMERIK 
You can find information on SINUMERIK under the following link:  

www.siemens.com/sinumerik 

Target group 
This publication is aimed at planning and application engineers. 

Benefits 
The Configuration Manual enables the target group to apply the rules and guidelines to be 
observed when configuring products and systems. It helps you select products and 
functions.  

The Configuration Manual helps the target group to create a system or plant configuration. 

Standard scope 
This documentation only describes the functionality of the standard version. Additions or 
revisions made by the machine tool manufacturer are documented by the machine tool 
manufacturer.  

Other functions not described in this documentation might be executable in the control. This 
does not, however, represent an obligation to supply such functions with a new control or 
when servicing. 

For the sake of simplicity, this documentation does not contain all detailed information about 
all types of the product and cannot cover every conceivable case of installation, operation, or 
maintenance. 

Technical Support  
You will find telephone numbers for other countries for technical support in the Internet under 
http://www.siemens.com/automation/service&support  

EC Declaration of Conformity 
The EC Declaration of Conformity for the EMC Directive can be found on the Internet at: 

http://support.automation.siemens.com/WW/view/de/10805517/134200 
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 Introduction 1 
1.1 General information on the contents of this description 

Position in the documentation landscape 
This documentation describes only those functions which are additionally provided by 
SINUMERIK Integrate Create MyHMI /WinCC V13.x. This assumes you are familiar with the 
standard scope of SIMATIC WinCC V13 (TIA Portal), which is described in the information 
system in the superordinate section "Visualizing processes". 

Some of the descriptions for SINUMERIK Integrate Create MyHMI /WinCC V13 only apply to 
the configuration of a PC system (e.g. PCU 50.5) with WinCC RT Advanced. These 
descriptions have the designation "(PC system)" in the title. 

In addition, you can use the example configuration procedures when configuring a PC 
system (Page 19) or a SIMATIC Panel (Page 20). 

For all other descriptions, refer to the corresponding documentation: 
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Information system of the TIA Portal 
A comprehensive help system is supplied with the TIA Portal for performing your tasks. It 
describes basic concepts, instructions and functions. 

 
Figure 1-1 Information system of the TIA Portal, "Visualizing processes" section 
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● To access the information system, click "Show help" in the "Help" menu. 

● When a reference is made in this documentation to a section in the information system, 
you can find the appropriate section at the specified location in the "Contents" tab. 

● In this documentation, you can find references to keywords in the information system. To 
navigate to the related content, open the "Index" tab in the information system, enter the 
first part of the keyword and double-click on the second part. 

 
Figure 1-2 Looking up keywords in the information system 

Alternatively, you can use the search function. 

TIA Portal, SIMATIC WinCC V13: Standard functions 
● You can find basic information on the TIA Portal and the user interface in the information 

system, section "Introduction to the TIA Portal > User interface and operation." 

● For more basic information, see the following sections in the information system: "Editing 
projects", "Configuring devices". 

● You can find help on the standard functions of SIMATIC WinCC V13 in the information 
system of the TIA Portal, section "Visualizing processes". 

Configuration of the PCU 50.5 
If you customize the user interface of SINUMERIK Operate on a PC system, the 
documentation for PCU 50.5 can provide assistance: 

● Software configuration of the PCU 50.5 
Base Software and Operating Software commissioning manual 

● Information on the hardware configuration, setup and networking of the PCU 50.5 
SINUMERIK 840D sl Operating Components and Networking manual 

Operation of SINUMERIK Operate 
You can find information on the operation of SINUMERIK Operate in the online help and in 
the Basic Software and HMI Software commissioning manual. 
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Configuration of SIMATIC Panels 
If you supplement SIMATIC Panel with SINUMERIK functionality, the documentation for your 
specific device can provide assistance. A list with links to the individual hardware 
documentation titles can be found in the information system of the TIA Portal, section 
"Hardware Documentation> HMI Manuals". 

Documentation for the supplied software and other software 
See Overview of TOOLS supplied (Page 15). 

Overview of all SINUMERIK documentation 
For up-to-date documentation on SINUMERIK, please refer to the Service&Support portal: 

SINUMERIK CNC automation system 
(http://support.automation.siemens.com/WW/view/en/10805517/133300) 

http://support.automation.siemens.com/WW/view/en/10805517/133300
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1.2 Functional scope 

1.2.1 Product features 
This add-on package for SIMATIC WinCC Advanced allows you to use special SINUMERIK 
HMI functions within WinCC. 

Supported HMI devices 
● SIMATIC Panel 

– SIMATIC Comfort Panel (e.g. KP400 Comfort) 

– SIMATIC Multi Panel (e.g. MP 177 6" Touch) 

– SIMATIC Mobile Panel (e.g. Mobile Panel 177 6" DP 

● PC systems with Windows 7 

– SIMATIC Panel PC 

– SINUMERIK PCU 50.5 Windows 7 

Runtime WinCC RT Advanced 
The runtime 'WinCC RT Advanced' can be used to integrate full-screen images into the 
OEMFrame area of SINUMERIK Operate. This runtime is used by both SIMATIC Panels and 
PC systems. 

● Runtime is already integrated for SIMATIC Panels. 

● For PC systems, the runtime in the TIA Portal must be configured and installed on your 
PC system (Page 26). Only Windows 7 is supported as an operating system on the PC 
system. 
"WinCC RT Advanced V13" Runtime is provided as well on the product DVD. 

Scope of functions of Runtime WinCC RT Advanced 
The scope of functions of Runtime when using SIMATIC Panels and PC systems is identical: 

● Ethernet communication with SINUMERIK 840D sl 

● MPI communication with SINUMERIK 840D sl 

● Visualization of NC variables 

● Visualization of GUD variables 

● Visualization of machine and setting data 

● NC alarms 

● DB2 alarms 

● Control for activating part programs 

● Triggering specific PI services (for example, NC restart, setting a password) 
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● Triggering a general PI service (using the "General PI service" function) 

● Standard functions of WinCC Compact/Advanced editions 

● Symbolic addressing of the PLC portion when using integrated connections 

● Example projects 
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1.2.2 Overview of TOOLS supplied 

Overview 
The following tools are additionally supplied with SINUMERIK Integrate Create MyHMI / 
WinCC V13.x: 

● GUD tool "WinCC import NC user data" 
This tool is used to generate a user database (Userdata.mdb) on the PG/PC from the 
definition files of the dynamic user data (MGUD.DEF, UGUD.DEF etc.). 
The GUD TOOL "WinCC import NC user data" (GUD_TOOL.exe) is copied to the 
installation directory when installing SINUMERIK Integrate Create MyHMI /WinCC V13.x. 
Start the GUD tool "WinCC import NC user data" with "Start > Siemens Automation > 
SINUMERIK > GUD Tool V13". 
See Creating a user database for global user data (Page 75). 

● HMI integration tool "Integration Sinumerik Operate" 
The HMI integration tool "Integration Sinumerik Operate" provides support for integrating 
the configuration for WinCC RT Advanced in SINUMERIK Operate on the PCU 50.5. 
Start the HMI integration tool with "Start > Siemens Automation > SINUMERIK > 
Integration Sinumerik Operate English Tool". 
See Integrating Runtime in SINUMERIK Operate (PC systems) (Page 130). 

 

The following software is also mentioned in this documentation: 

 
Software Source 
WinCC TagConverter Available on the Service & Support pages on the Internet:Tag 

converter for WinCC 
(http://support.automation.siemens.com/WW/view/en/56078300) 

SINUMERIK Integrate Access MyMachine /P2P Can be ordered in SIEMENS Industry Mall 
(https://ebstage.automation.siemens.com/mall/en/us/Catalog/Product
s/10166235) 

 

http://support.automation.siemens.com/WW/view/en/56078300
https://ebstage.automation.siemens.com/mall/en/us/Catalog/Products/10166235
https://ebstage.automation.siemens.com/mall/en/us/Catalog/Products/10166235
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1.3 Communications principle 

Overview 
A SINUMERIK NCU includes the integrated subcomponents PLC and NCK. WinCC uses 
different communication drivers to access these subcomponents. 

● PLC 

– Behaves like an S7-300 controller in respect to data communication. 

– Uses the communication driver "SIMATIC S7-300/400". 

● NCK 

– Requires special tag descriptions and specific services. 

– Uses the communication driver "SINUMERIK NC". The "SINUMERIK NC" 
communication driver allows you to read/write NC tags and GUDs as well as to access 
PI services. 
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Table 1- 1 Assignment of interfaces, HMI devices and communication drivers 

HMI device Runtime Communication drivers NCU interface 

PLC NCK 
PCU 50.5 with 
SINUMERIK 
Operate  

Pluggable WinCC 
RT Advanced 

SIMATIC S7-
300/400 

SINUMERIK 
NC 

Ethernet interfaces 
of the CP (X120, 
X130) 

SIMATIC Panel Integrated WinCC 
RT Advanced 

SIMATIC S7-
300/400 

SINUMERIK 
NC 

MPI (X136) 

SIMATIC S7-
300/400 

SINUMERIK 
NC 

Ethernet interfaces 
of the CP (X120, 
X130) 

You can use different ports on the NCU depending on the HMI device.  

 
Figure 1-3 Communication principle 



Introduction  
1.5 Licensing 

 SINUMERIK Integrate Create MyHMI /WinCC V13 
18 Configuration Manual, 02/2014 

1.4 Sample configuration procedure 

1.4.1 Overview 
An exemplary configuration procedure when using a PC system (Page 19) or SIMATIC 
Panel (Page 20) can be found in the overview tables. 

An example project (Page 21) is provided with the installation, which you can open and view 
in the TIA Portal. 
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1.4.2 Configuration procedure when using PC systems 
The following table shows an exemplary configuration procedure when using a PC system 
with WinCC RT Advanced. 

For descriptions that relate to the standard scope of SIMATIC WinCC Advanced, refer to the 
corresponding help in the information system of the TIA Portal (see also: Position in the 
documentation landscape (Page 9)).  

 
No. Step Additional information 
1 Install the software on the PCU 50.5 Installing software on the PC system (PCU 50.5) (Page 26) 
2 Configure the PG/PC interface Configuring the PG/PC interface (PC systems) (Page 28) 
3 Create a project Information system, keyword "Project, create" 
4 Add a PC system and WinCC RT Inserting PC system and Runtime (Page 42) 
5 Specify screen resolution of the operator panel front Configuring screen resolution (PC systems) (Page 46) 
6 Add screens and master copies, if needed Information system, section "Visualizing processes > 

Creating screens > Working with screens" 
7 Define start screen Information system, keyword "Start screen" 
8 Configure screen size 

 
Configuration of the screen size (PC systems) (Page 48) 

9 Add NCU Information system, keyword "NCU, add" 
10 Create a connection Overview (Page 53) 
11 Configure the language settings Overview (Page 117) 
12 Configure tags Configuring variables (Page 61) 
13 Configure alarms Overview (Page 79) 
14 Configure screen objects Overview (Page 97) 
15 Configure system functions Overview (Page 103) 
16 Compile project Information system, section "Visualizing processes> Compile 

and Download" 
17 Test configuration as simulation Information system, keyword "Compile, project" 
18 Loading configuration to a PCU 50.5 

If you change your configuration after loading it in the 
TIA Portal, you must compile it again and download it 
to the PC system. 

Overview (Page 125) 

19 Integrate "WinCC RT Advanced" Runtime in 
SINUMERIK Operate 
You usually need to integrate Runtime in 
SINUMERIK Operate only once. You only need to 
repeat the process if you want to change something 
in the settings for the integration of Runtime in 
SINUMERIK Operate. 

Integrating Runtime in SINUMERIK Operate (PC systems) 
(Page 130) 
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1.4.3 Configuration procedure when using SIMATIC Panels 
The following table shows an exemplary configuration procedure when using a SIMATIC 
Panel. 

For descriptions that relate to the standard scope of SIMATIC WinCC Advanced, refer to the 
corresponding help in the information system of the TIA Portal (see also: Position in the 
documentation landscape (Page 9)).  

 
No. Step Additional information 
1 Create a project Information system, keyword "Project, create" 
2 Add a SIMATIC Panel Adding a SIMATIC Panel (Page 49) 
3 Add NCU Information system, keyword "NCU, add" 
4 Create a connection Overview (Page 53) 
5 Configure the language settings Overview (Page 117) 
6 Add screens and master copies Information system, section "Visualizing processes > 

Creating screens > Working with screens" 
7 Define start screen Information system, keyword "Start screen" 
8 Configure tags Configuring variables (Page 61) 
9 Configure alarms Overview (Page 79) 
10 Configure screen objects Overview (Page 97) 
11 Configure system functions Overview (Page 103) 
12 Compile project Information system, section "Visualizing processes> Compile 

and Download" 
13 Test configuration as simulation Information system, keyword "Compile, project" 
14 Load configuration in SIMATIC Panel Information system, section "Visualizing processes> Compile 

and Download" 
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1.4.4 Example projects 

General 
The examples are located in the following directory: 

● <Installation directory of TIA Portal>\Automation\Portal V13\Data\HMI\Sinumerik\samples 

Example NCSecurity.ap*  
"NCSecurity.ap*" shows how the visibility and operability of an I/O field can be controlled 
using the NC tag "Access Level".  

The most important settings are to be found in the properties dialog box of the I/O field in the 
area "Animation" > "Display". 

 
Figure 1-4 Settings in the NCSecurity example project 



Introduction  
1.5 Licensing 

 SINUMERIK Integrate Create MyHMI /WinCC V13 
22 Configuration Manual, 02/2014 

1.5 Licensing 

1.5.1 Licensing when using PC systems with SINUMERIK Operate 
You need the following licenses: 

● Engineering system 

SIMATIC WinCC Advanced V13 

● Runtime 

License P61 - SINUMERIK Integrate Run MyHMI /WinCC 

Article No.: 6FC5800-0AP61-0YB0 

Message if there is no license 

In SINUMERIK Operate, if option "SINUMERIK Integrate Run MyHMI /WinCC" is not 
licensed, then a request for a license is displayed during the runtime. 

 
The name of the software option to be licensed differs depending on the software version; 
however, the license to be ordered is identical (Article No.: 6FC5800-0AP61-0YB0): 

– SINUMERIK Operate 4.6 or newer: "SINUMERIK Integrate Run MyHMI /WinCC" 

In SINUMERIK Operate, license option P61 "SINUMERIK Integrate Run MyHMI 
/WinCC" so that the request is no longer displayed. 

– SINUMERIK Operate 4.5 SP2 or older: "Sinumerik HMI sl Runtime OA Configuring" 

In SINUMERIK Operate, license option P61 "Sinumerik HMI sl Runtime OA 
Configuring" so that the request is no longer displayed. 
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1.5.2 Licensing for SIMATIC Panels 
You need the following licenses: 

● Engineering system 

Basic WinCC license 

● Runtime on SIMATIC Panel 

License P03 - SINUMERIK 840D sl SINUMERIK Integrate Run MyHMI /SIMATIC OP 

6FC5800-0AP03-0YB0 
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 Installation 2 
2.1 System requirements and installation 

SINUMERIK Integrate Create MyHMI /WinCC V13.x represents an add-on package for 
SIMATIC WinCC Advanced V13 (TIA Portal) with additional setup. 

System requirements 
All hardware and software requirements for installing SIMATIC WinCC Advanced V13 apply. 
(See readme file for SIMATIC WinCC Advanced V13) 

Requirement 
● All other applications (e.g. Microsoft Word and TIA Portal) are closed. 

● SIMATIC WinCC Advanced V13 is installed on the PG/PC. 

Procedure 
To install SINUMERIK Integrate Create MyHMI /WinCC V13.x, follow these steps: 

1. In Windows Explorer, browse to the root directory of the product DVD. 

2. Double-click the setup file "Start.exe" from SINUMERIK Integrate Create MyHMI /WinCC 
V13. 

3. Install the software using the installation wizard. 

Result 
SINUMERIK Integrate Create MyHMI /WinCC is installed on the PG/PC. 

If you expand SINUMERIK Operate with an operating area on a PC system (PCU 50.5) via 
the WinCC RT Advanced, you must install Runtime WinCC RT Advanced as well as 
SINUMERIK Integrate Create MyHMI /WinCC (Page 26) on it. 
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2.2 Installing software on the PC system (PCU 50.5) 
If you expand SINUMERIK Operate with an operating area on a PC system (PCU 50.5) via 
WinCC RT Advanced, you must also install the following on it in the correct sequence: 

● Runtime WinCC RT Advanced included on the product DVD in the "Support" directory 

● SINUMERIK Integrate Create MyHMI /WinCC V13 

However, you do not need to install SIMATIC WinCC Advanced V13 engineering system 
(TIA portal) on the PC system. 
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Procedure 
To install SINUMERIK Integrate Create MyHMI /WinCC on the PC system, follow these 
steps: 

1. On the product DVD, open the directory "\Support\WinCC RT Advanced" and double-click 
on the WinCC RT Advanced setup file "Start.exe" 

 
Figure 2-1 Starting WinCC RT Advanced runtime setup 

2. Change to the master directory of the product DVD and double-click the setup file 
"Start.exe" from SINUMERIK Integrate Create MyHMI /WinCC V13. 

 
Figure 2-2 Starting SINUMERIK Integrate Create MyHMI /WinCC setup 



Installation  
2.3 Configuring the PG/PC interface (PC systems) 

 SINUMERIK Integrate Create MyHMI /WinCC V13 
28 Configuration Manual, 02/2014 

2.3 Configuring the PG/PC interface (PC systems) 
The PG/PC interface of the PCU 50.5 must be set for operation via TCP/IP for "WinCC RT 
Advanced" Runtime to be able to read data from the NCU. 

Procedure 
To configure the PG/PC interface of the PCU 50.5, follow these steps: 

1. Open the "Set PG/PC Interface" tool in the Control Panel. 

2. Check the following settings: 
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 Migrating projects 3 
3.1 Migrating projects 

You can migrate a SINUMERIK project as well as other projects from WinCC flexible to the 
TIA Portal. 

As a result of the various operating systems that can be used, you cannot install 
"SINUMERIK HMI configuring package WinCC flexible 2008" and WinCC (TIA portal) on the 
same PG/PC. 

For the migration, you need the migration tool "Project migration for WinCC flexible 2008
SP2/SP3", which you must select when setting up WinCC (TIA portal) in the product 
configuration.  

 
Figure 3-1 Setting up WinCC (TIA portal): Set the option box for project migration 

Restrictions 
The following restrictions apply to migration of SINUMERIK projects: 

● You can migrate projects from WinCC flexible 2008 SP2 

● WinCC flexible projects integrated in STEP 7 V5.x cannot be directly migrated (Page 34) 

Read the information on migration provided below as well: 

● SINUMERIK PCs and SIMATIC Panel PCs 

● SIMATIC Panel 

A tabular comparison of the functions in WinCC flexible and WinCC (TIA Portal) is available 
in the section Comparison of functions (Page 31). 
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Additional information 
For additional information concerning the migration of projects from WinCC flexible, read the 
following information: 

● Information system of the TIA Portal, section "Migrating projects and programs > 
Migrating projects in a TIA Portal project > Migrating WinCC flexible projects (Advanced)". 

● FAQ WinCC (TIA portal) -- working with projects -- migrating projects 
(http://support.automation.siemens.com/WW/view/en/54702181). 

Special features for SINUMERIK projects 
The following HMI devices with SINUMERIK components can be migrated: 

● SINUMERIK PCs and SIMATIC Panel PCs 

● SIMATIC Panel 

SINUMERIK PCs and SIMATIC Panel PCs 

The following must be observed when migrating SINUMERIK projects: 

● In the TIA Portal, you configure the PC system (e.g. PCU 50.5) instead of the operator 
panel front. This is changed automatically during the migration. You enter the screen 
resolution of the operator panel front in the runtime settings (Page 46). 

● The input controls specific to HMI Advanced are not transferred. 

● HMI controls for file management and NC editor are not supported. 

● Integration in the m:n concept is not supported. 

● The communication driver for the PLC-channel SINUMERIK PLC is switched over to the 
SIMATIC S7-300/400 communication driver. 

● Automatic display of DB2 alarms is not supported. 
Import the DB2 alarms separately in the TIA Portal (Page 36). 

● GUD tags are not automatically associated with the migration. 
Connect migrated GUD tags again after the migration. (Page 36) 

● Multidimensional GUD arrays are not used in the TIA Portal even with PC systems (as 
known from WinCC flexible CE HMI devices). 
Linearize multidimensional GUD arrays or create new ones (Page 68). 

● Use the WinCC TagConverter (Page 35) to convert tags from STEP 7 V5.x into a format 
suitable for import in WinCC. 

SIMATIC Panel 

● SIMATIC panels as of version 13.0.0.0 support the SINUMERIK parameter indexing 
method and must no longer contain the parameter number incremented by 1. 
If you configure a SIMATIC Panel as of version 13.0.0.0, adjust the configuration of the R 
parameters (Page 34). 

http://support.automation.siemens.com/WW/view/en/54702181
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3.2 Comparison of functions 
SINUMERIK Integrate Create MyHMI /WinCC V13 comes with a number of functional 
changes as compared to the SINUMERIK HMI configuration software WinCC flexible 2008. 

The tables below compare the range of functions of these two products: 

● Functionality of SINUMERIK Integrate Create MyHMI /WinCC compared to the 
SINUMERIK HMI configuration package WinCC flexible 2008 for configuring a PC system 

● Functionality of SINUMERIK Integrate Create MyHMI /WinCC compared to the 
SINUMERIK HMI configuration package WinCC flexible 2008 for configuring SIMATIC 
Panels 

Additional information 
● For information on the SINUMERIK HMI configuration package WinCC flexible 2008, see 

the corresponding configuration manual "SINUMERIK HMI Configuring Package WinCC 
flexible 2008" 

● For an overview of the migration to SIMATIC WinCC V13, see the information system of 
the TIA Portal, keyword "Migration to WinCC V13" 
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Comparison of the functional scope 

Table 3- 1 Functionality of PC systems (connection to NC and PLC) 

Functionality SINUMERIK HMI 
configuration software 
WinCC flexible 2008 

SINUMERIK Integrate 
Create MyHMI /WinCC 

Configuration for SINUMERIK HMI 
Advanced 

x - 

Configuration for SINUMERIK Operate - x 
Ethernet communication with SINUMERIK 
840D sl 

x x 

PROFIBUS communication with 
SINUMERIK 840D sl 

- - 

MPI communication with SINUMERIK 840D 
sl 

x - 

MPI communication with SINUMERIK 840D 
pl 

x - 

Visualization of NC variables x x 
Visualization of GUD variables x x 
Visualization of machine and setting data x x 
NC alarms x x 
DB2 alarms x x 
Integration into the m:n concept of 
SINUMERIK HMI Advanced (up to 8 NCUs) 

x - 

Controls for HMI data management and NC 
editor 

x - 

Input controls of SINUMERIK HMI 
Advanced 

x - 

Control for activating part programs - x 
Triggering specific PI services (for example, 
NC restart, setting a password) 

x x 

Triggering a general PI service (using the 
"General PI service" function) 

x x 

Coordinated language change SINUMERIK 
HMI - WinCC 

x x 

Symbolic addressing of the PLC element in 
STEP 7 integration 

x x 

Example project x x 
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Table 3- 2 Functionality of SIMATIC Panel (connection to NC and PLC) 

Functionality SINUMERIK HMI 
configuration software 
WinCC flexible 2008 

SINUMERIK Integrate 
Create MyHMI /WinCC 

Ethernet communication with SINUMERIK 
840D sl 

x x 

PROFIBUS communication with 
SINUMERIK 840D sl 

x x 

MPI communication with SINUMERIK 840D 
sl 

x x 

MPI communication with SINUMERIK 840D 
pl 

x - 

Visualization of NC variables x x 
Visualization of GUD variables x x 
Visualization of machine and setting data x x 
NC alarms and NC messages x x 
Control for activating part programs x x 
Triggering specific PI services (for example, 
NC restart, setting a password) 

x x 

Triggering a general PI service (using the 
"General PI service" function) 

x x 

Example project x - 
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3.3 Indexing of R parameters and GUD arrays 
The method for indexing R parameters or GUD arrays in the TIA Portal depends on the 
employed Runtime version or the corresponding SIMATIC Panel: 

● If you configure a WinCC RT Advanced with a version earlier than 13.0.0.0 or a SIMATIC 
Panel that uses an older Runtime version (CE Panel), note the following when indexing R 
parameters and GUD arrays: 
Address the R parameter higher by 1 than required during configuration. To display R5 in 
runtime, for example, you need to configure R6. (This indexing method is the same 
method used in WinCC flexible for SIMATIC CE panels.) 

When configuring GUD arrays, address the first GUD element with index 1 (as already 
done in WinCC flexible), e.g. def CHAN INT MyGUD[3] 

Address the individual elements with MyGUD[1], MyGUD[2], MyGUD[3]. 

● If you configure a WinCC RT Advanced as of version 13.0.0.0 (for example, all SIMATIC 
Comfort Panels or a PCU 50.5 with WinCC RT Advanced), the exact R parameter you 
have configured is displayed in runtime. 

3.4 Migrating WinCC flexible projects integrated in STEP 7 V5.x 
Projects integrated in STEP 7 cannot be migrated. 
If a WinCC flexible project is integrated in STEP 7, then WinCC flexible ES can be selected 
under "Project > Copy from STEP 7". After selecting an archive location, a copy of the 
integrated STEP 7 project is saved there. This autonomous WinCC project can then be 
migrated into the TIA Portal. 

The connection of the symbols in STEP 7 is lost in the process. 
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3.5 Configure PLC variables symbolically 
Use the WinCC TagConverter to convert tags from STEP 7 V5.x into a format suitable for 
import in WinCC. 

 
Figure 3-2 WinCC TagConverter 

 

You can find this tool and relevant documentation on the Service & Support pages on the 
Internet: 

Tag converter for WinCC (http://support.automation.siemens.com/WW/view/en/56078300) 

http://support.automation.siemens.com/WW/view/en/56078300
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3.6 Post processing of migrated GUD variables 
After you have migrated a WinCC flexible project with GUD tags in the TIA portal, you must 
create a Creating a user database for global user data (Page 75) and reconnect the GUD 
tags in the "HMI tags" editor. 

Precondition 
● A user database with GUD tags suitable to the TIA Portal project is available. 

See Creating a user database for global user data (Page 75). 

Procedure 
To edit the migrated GUD tags, follow these steps: 

1. In the project navigation in folder "HMI tags" click on the command "Show all tags", e.g. 
"PC system_1 > HMI_RT_1 > HMI tags > Show all tags". 
The editor "HMI tags" is opened, in which all tags are on display, including migrated GUD 
tags. 

2. In the "Address" field, click on the "Expand" symbol. 

The dialog for selecting the SINUMERIK tags opens. You can find the migrated GUD tags 
under "GUD: dynamic user data". 

 
Figure 3-3 Dialog for selecting SINUMERIK tags with GUD 

3. Navigate through the structure to the desired tag, select it and click the "Confirm" icon. 

4. Click on the "Expand" icon in the "Address" field for each migrated tag, and select the 
GUD tag to be addressed. 
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Result 
The GUD tags are reconnected. 

 
Figure 3-4 GUD tags associated with newly connected address and symbolic name 

You must subsequently linearize multi-dimension GUD arrays. See Overview (Page 68). 
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 Device configuration 4 
4.1 Configurable user interface 

PC systems 
For PC systems with WinCC RT Advanced, the complete user interface is available for 
configuring screens for an additional operating area of a SINUMERIK Operate user interface. 

Because you do no select a specific operator panel front for the configuration of a PC 
system, all available function keys are basically displayed on the added screens. 

You can specifically set the screen resolution (Page 46) of the operator panel front and also 
subsequently change it. 

 
Figure 4-1 User interface of a screen for configuration of the PCU 50.5 

When you configure the function keys, make sure you only use the keys that are actually 
available on the operator panel front. 
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SIMATIC Panel 
If you configure a SIMATIC Panel, you must insert a specific panel (for example, KP 1200 
Comfort). The only buttons displayed for the user interface of a screen are those that are 
available on the respective SIMATIC Panel. 

In addition, the screen resolution is already set specifically for the added SIMATIC Panel and 
cannot be changed. 

 
Figure 4-2 User interface of a screen for a SIMATIC Panel KP 1200 Comfort 

See also 
Loading and integrating a configuration (PC systems) (Page 125) 
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4.2 Runtime configuration 

Overview 
With the Runtime WinCC RT Advanced, you can adapt the user interface of SINUMERIK 
Operate on a PC system (Page 19) or SIMATIC Panel with SINUMERIK functionality 
(Page 20). 

Make a different selection for Runtime or the Runtime version depending on the HMI device 
used: 

● If you add a SIMATIC Panel, you do not need to insert Runtime separately. SIMATIC 
Panels have integrated Runtime, which is automatically available when added. You select 
the Runtime version when you add the SIMATIC Panel. 

● When you add a PC HMI device and switch to the device view, Runtime is shown in the 
hardware catalog. When you select Runtime, you can select the Runtime version in the 
"Information" area of the hardware catalog. 

 
Figure 4-3 Device view with hardware catalog (on the right in the image) 
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4.3 Inserting PC system and Runtime 
The following components in WinCC allow an operating area to be configured for a 
SINUMERIK Operate user interface: 

● SINUMERIK PC system (e.g. PCU 50.5-P with Windows 7) 

● WinCC RT Advanced 

Requirement 
● The TIA Portal has been started. 

● A project is open or created. 

● The project view is active. 
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Procedure 
To add a PC system and Runtime WinCC RT Advanced, follow these steps: 

1. Click "Add new device" in the project tree and click on the "PC systems" button. 

 
Figure 4-4 Add PC system 

All available PC systems are displayed in the folder structure. 

2. Under "SINUMERIK Operator Components > PCU", select an operator component (e.g. 
"PCU 50.5"), assign a device name (e.g., "PCU_1"), then confirm with "OK". 

The device is added, and the device view opens. 
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3. In the hardware catalog, select the runtime software from "SIMATIC HMI application > 
WinCC RT Advanced", change the version in the "Information" section, if needed, and 
drag it to a free slot of the device in the device view. 

The configured Runtime version must match the current Runtime version in use on the 
PC system. 

 
Figure 4-5 Adding WinCC RT Advanced 
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Result 
In the project tree, the configured runtime (e.g. "HMI_RT_1 [WinCC RT Advanced]") is added 
to the created device (e.g. "PC-System_1 [PCU 50.5-P]]"). 

This view provides the following configuration editors: 

● "Connections"  (Page 53) 

● "HMI variables" (Page 61) 

● "HMI messages" (Page 79) 

● "Screens" (Page 97) 

 

Next, you set the screen resolution of your operator panel front (Page 46). 
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4.4 Configuring screen resolution (PC systems) 

Introduction 
If you configure a PC system, the default for the screen resolution of the HMI device in 
runtime is 800x600. Therefore, depending on the HMI device you are using, you may need 
to adjust this setting so that the configured picture is a full screen on the target system. 

If you enter the wrong screen resolution here, the scroll bars or the picture will not fill the 
screen on the HMI device. 

If you later change the screen resolution in the runtime settings, you first need to enable the 
"Fit to screen" option in the settings before making the settings in the TIA Portal (see below). 

Requirement 
● A project with a PC system and Runtime software has been created. 

See: Inserting PC system and Runtime (Page 42) 

● The project view is active. 

Procedure 
To set the screen resolution of the target system, proceed as follows: 

1. Activate the "Fit to screen" option button in the "Tools > Settings > Visualization > Resize 
screens and screen objects" menu. 

2. Open the runtime settings in the project tree, for example, under "PC_System_1 > 
HMI_RT_1 > Runtime settings > Screen resolution". 

3. Make the appropriate setting for your operator panel front: 

 

Operator panel front Resolution Screen format 
OP 010 640 x 480 Standard 
 800 x 480 Widescreen 
OP 012 800 x 600 Standard 
 1366 x 768 Widescreen 
OP 015 1024 x 768 Standard 
OP 019 1280 x 1024 Standard 
 1920 x 1080 Widescreen 
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  Note 

"Screen resolution" setting must match actual resolution of the operator panel front used 

If the wrong screen resolution has been entered in the Runtime settings, the scroll bars or 
the picture will not fill the screen on the HMI device at runtime. 

If the screens are not displayed correctly in runtime, adjust the setting as described 
above. 

 

4. To prevent the display of scrollbars, activate full-screen mode with "Runtime settings > 
General". 
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4.5 Configuration of the screen size (PC systems) 
To prevent the configured screens from covering the header of SINUMERIK Operate, for 
example, you can reduce the size of the configured screens. 

You can change this setting at any screen. The setting is always applied to all screens. 

Using drag-and-drop to make the screen or template smaller. 

 
Figure 4-6 Changing the screen size 

You can find more information about master copies in the information system of the TIA 
Portal, section "Visualizing processes > Creating screens > Basics > Working with master 
copies". 
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4.6 Adding a SIMATIC Panel 
The following components are required in WinCC to use the SINUMERIK functionality on a 
SIMATIC Panel: 

● Suitable SIMATIC Panel/Comfort Panel/Multi Panel 

Requirement 
● The TIA Portal has been started. 

● A project is open or created. 

● The project view is active. 
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Procedure 
To add a SIMATIC Panel, follow these steps: 

1. In the project tree, click on "Add new device" and click the "HMI" button. 

 
Figure 4-7 Adding a SIMATIC Panel 

The "Add new device" dialog box opens and the folder structure displays all available 
SIMATIC Panels. 
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2. Make the required settings: 

 

Element Purpose 
Device name Assign a device name (e.g. "HMI_SIMATIC_Panel "). 
Folder structure Under "HMI", select a SIMATIC Panel (for example, "MP 177 6" mono 

DP") 
Version Runtime is integrated for SIMATIC Panels. Select the required 

Runtime version in this drop-down list. 
Open the device wizard To start the HMI device wizard after adding the device, select this 

check box. 
Use the HMI device wizard to define the basic settings for your HMI 
device, for example, the screen layout or the connection to your PLC. 
Note that you still need to make other settings in the device view, for 
example, you need to create the connection to the NC. 

3. Click "OK" to confirm your settings. 

Result 
The device is added and, depending on your settings, the HMI device wizard or the project 
view opens. 

The following editors are available in the project tree below the device (for example, 
"HMI_SIMATIC_Panel [MP 177 6" mono DP]"): 

● "Connections" 

● "HMI variables" 

● "HMI messages" 

● "Screens" 
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 Configuring connections 5 
5.1 Overview 

You can create two different types of connections in the TIA Portal, integrated and non-
integrated connections: 

● You configure integrated connections in the "Devices & Networks" editor (Page 54) after 
you have added the communication partner (e.g. integrated PLC of the NCU). 

– You can create the connection to the PLC as integrated connection. 

– An integrated connection to the PLC is required in order to import DB2 alarms. 

– However, the "Integrated connection" connection type is not available for the 
connection to the NC. 

● You create non-integrated connections in the "Connections" editor (Page 57). The 
communication partner needs not be added in this case (for example, integrated PLC of 
the NCU). 

For more information about integrated and non-integrated connections, see the information 
system of the TIA Portal, keyword "non-integrated connection" or "integrated connection". 
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5.2 Configure an integrated connection 
You can create the HMI connection in a user-friendly fashion via the network view. 

This function can only be used to generate a connection to the PLC. The connection to the 
NCK must be configured as a non-integrated connection (Page 57). 

Requirement 
● The SINUMERIK 840D sl TIA Portal Toolbox is installed. 

(Required to configure a SINUMERIK NCU) 

● An NCU has been added. 

● A PC system with WinCC RT Advanced or a SIMATIC Panel has been added. 
See Inserting PC system and Runtime (Page 42) 

● The network view is active. 
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Procedure 
To create an integrated connection to the PLC, follow these steps: 

1. Click the "Connections" button and select "HMI connection" from the drop-down list. 

 
Figure 5-1 Connections 

The components that you can connect (PLC and WinCC RT) have a colored background. 
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2. Use drag-and-drop to create a connection from the WinCC RT Advanced or the SIMATIC 
Panel to the PLC. 

 
Figure 5-2 Creating a connection with drag-and-drop - to PCU 50.5-P and WinCC RT Advanced 

in the example 

Result 
The connection to the PLC is created as an integrated connection and it is automatically 
assigned a name. 

You can see the connection in the "Connections" editor and change the assigned name, if 
necessary. 
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5.3 Configuring a non-integrated connection 
You create a connection to each of the PLC and NC subcomponents in the "Connections" 
editor. The communication driver to be selected depends on the subcomponent: 

● PLC: Communication driver "SIMATIC S7-300/400" 

● NC: Communication driver "SINUMERIK NC" 

 

Requirement 
● You have created a project. 

● The HMI device to be configured has been added (SIMATIC Panel or PC system with 
WinCC RT Advanced). 
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Procedure 
To create a non-integrated connection, follow these steps: 

1. In the project tree, navigate to the device to be configured. 

2. Double-click "Connections" in the project tree below the device, for example, "PC-
System_1 > HMI_RT_1 > Connections". 
The editor for connections opens. 

 
Figure 5-3 Editor for connections with two non-integrated connections 

3. Double-click "<Add>" in the "Name" column and assign a meaningful name, for example, 
"Connection NC". 
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4. Select the appropriate option from the "Communication drivers" drop-down list: 

– Connection to the PLC: "SIMATIC S7-300/400" 

– Connection to NC: "SINUMERIK NC" 

5. In the "Parameters" tab, make the required settings for each individual connection : 

– In the "Interface" drop-down list, select the required option, for example, 
"ETHERNET". The interface must be identical for both connections. 

 
  Note 

The interface type must match 

Both connections must use the same interface type. 

Both connections will be marked as being faulty if the interface type does not match. 
 

– Specify the slot in the "Controller" section:  
Connection to the PLC: Expansion slot 2 
Connection to the NC: Expansion slot 4 

– Define an IP address in the "Controller" section. The IP address entered must be 
identical for both connections (connection to PLC and connection to NC). 

 
  Note 

Operating PCU 50.x on the company network 

If the PCU 50.x is not in the system network, but operated in a company network, then 
the IP address allocated via the DHCP server must be entered for the HMI device. 
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 Configuring variables 6 
 

You can create PLC tags in the "HMI tags" editor. 

The PLC tags available depend on the selected connection and the communication channel 
defined in the connection:  

● For the "SIMATIC S7-300/400" communication channel the range of tags that can be 
used corresponds to the S7-300/400 channel. 
You can find additional information in the information system of the TIA Portal, keyword 
"Tag, creating an external tag". 

● For the "SINUMERIK NC" communication channel, the following PLC tags can be used: 

– All NC tags of the operator panel interface (Page 63) 

– All general, channel-specific and axis-specific machine and setting data (Page 63) 

– GUD tags (user-defined PLC tags) (Page 66) 

These variables can be configured using their symbolic name.  

Additional information 
General information about working with tags in WinCC is available in the information system 
of the TIA Portal, section "Visualizing processes > Working with tags". 
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6.1 Indexing of R parameters and GUD arrays 
The method for indexing R parameters or GUD arrays in the TIA Portal depends on the 
employed Runtime version or the corresponding SIMATIC Panel: 

● If you configure a WinCC RT Advanced with a version earlier than 13.0.0.0 or a SIMATIC 
Panel that uses an older Runtime version (CE Panel), note the following when indexing R 
parameters and GUD arrays: 
Address the R parameter higher by 1 than required during configuration. To display R5 in 
runtime, for example, you need to configure R6. (This indexing method is the same 
method used in WinCC flexible for SIMATIC CE panels.) 

When configuring GUD arrays, address the first GUD element with index 1 (as already 
done in WinCC flexible), e.g. def CHAN INT MyGUD[3] 

Address the individual elements with MyGUD[1], MyGUD[2], MyGUD[3]. 

● If you configure a WinCC RT Advanced as of version 13.0.0.0 (for example, all SIMATIC 
Comfort Panels or a PCU 50.5 with WinCC RT Advanced), the exact R parameter you 
have configured is displayed in runtime. 
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6.2 Configuring NC tags 

6.2.1 Overview 
You can select SINUMERIK tags in the "HMI tags" editor in the "Address" field, if the NC 
connection has been selected in the "Connection" field. 

 

 Note 
Methods for indexing R parameters and GUD arrays 

The method for indexing R parameters and GUD arrays depends on the employed Runtime 
version or SIMATIC Panel. 

See: Indexing of R parameters and GUD arrays (Page 62) 
 

Precondition 
● An NC connection with communication channel "SINUMERIK NC" has been created. 
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Procedure 
To create an external tag, proceed as follows: 

1. In the project navigation, open the "HMI tags" folder and double-click on "Show all tags" 
or on a tag table. 

2. In the tag table, double-click in the "Name" column on "Add". 
A new tag is created. 

3. Select a previously created connection with the "SINUMERIK NC" communication driver 
in the "Connection" field. 

4. Click the "Expand" icon in the "Address" field. 
The dialog for selecting SINUMERIK tags opens. 

 
Figure 6-1 Dialog for selecting SINUMERIK tags 

5. Select the required tag in the structure, adapt the values, if necessary (for example, for 
the channel or axis), and click "Confirm". 

6. Make optional settings in the inspector window under "Properties > Properties > General": 

 

 Note 
Creating tags directly at the point of use 

You can also create new tags directly at the point of use, for example, at an I/O field. To do 
this, click the "Add" button in the object list. You then configure the new tag in the Inspector 
window. 
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Additional information 
You can find information on the structure and the processing of NC tags in the following 
documentation: 

● List manual for NC tag and interface signals (LIS2sl), section "NC tag". 

● Online help "Help for OPI tags SINUMERIK 810D, 840D, FM-NC", opened in the TIA 
Portal via the tooltip of a specific tag. 

 
Figure 6-2 Opening via tooltip of the NC tags 
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6.3 Configuring GUD tags 

6.3.1 Introduction 

Overview 
GUD are Global User Data that users can define themselves on the NCU and subsequently 
use in the NC. WinCC lets you visualize these tag values. 

● To use the GUD tags of the NCU in the TIA Portal, you must first import (Page 73) them. 

● If you work with GUD arrays, read the corresponding Notes for GUD arrays in the TIA 
Portal (Page 68). 

● Whenever you change the DEF files, you must also repeat the import or recreate the user 
database (Page 73). 

● If you have extended the GUD tags offline in theTIA portal, you must copy the modified 
DEF files back to the NCU (Page 77). 

The DEF files of the GUD database used in the TIA portal must match the DEF files in the 
NC in order that the runtime WinCC RT Advanced can correctly access the GUD tags. 

At an early phase in the configuring, coordinate the GUDs to be used on the NCU and in 
the TIA Portal. If subsequent additions are required, attach these at the end of the DEF 
files, below the existing data. If you make changes to the complete DEF file, you must 
reconnect all GUD of this DEF file. 

 
  Note 

Data consistency between the TIA Portal and SINUMERIK Operate 

If you change something in the data in SINUMERIK Operate after the import into the TIA 
portal, these changes are not automatically synchronized between the systems. 

Repeat the import process, therefore, if you change something in the GUD data in 
SINUMERIK Operate. 

 

Character explanation 

Table 6- 1 Character explanation for the definition of GUD tags 

Value Meaning 
NCK Global PLC tag 
CHAN Channel-specific tag 
Type Tag type (BOOL, CHAR, INT, REAL, STRING) 
Name Tag name 
Rows Line number 
Columns Column number 
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File types 
The following file types are of importance when working with GUD tags: 

● Definition files of dynamic user data: <file name>.def 

The dynamic user data is communicated to the NCK using these definition files. 

These files are required during Runtime on the PLC. 

These files are required for the GUD tool "WinCC import NC userdata" on the 
configuration PC. 

● File of the user database: Userdata.mdb 

The file of the user database is required to display user data within WinCC TIA Portal 
V13.x during tag configuration. 
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6.3.2 Configuring GUD arrays 

6.3.2.1 Overview 

Introduction 
GUDs in the NCU can also be defined as arrays, specifically as one, two and three-
dimensional arrays. 

Table 6- 2 Definition of the GUD arrays in the NCU 

GUD definition Example 
DEF {NCK|CHAN} type Name[number of lines, 
number of columns] 

DEF NCK REAL REALNGUD[2,3] 

 DEF CHAN REAL REALCGUD[2,3] 
DEF {NCK|CHAN} STRING[number of 
characters] Name[number of strings] 

DEF NCK STRING[8] NTEXT[5] 

In WinCC (TIA Portal), however, multi-dimensional arrays must be linearized, which means 
access is only performed via a single index: 

● In one-dimensional arrays, this is simply the required index, starting at 0. 

● With multi-dimensional arrays, the index must be calculated. 

If, in WinCC (TIA Portal) you wish to dynamically access a GUD array via an index tag, 
observe the associated notes (Page 72). 

 

 Note 
Methods for indexing R parameters and GUD arrays 

The method for indexing R parameters and GUD arrays depends on the employed Runtime 
version or SIMATIC Panel. 

See: Indexing of R parameters and GUD arrays (Page 62) 
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Table 6- 3 Addressing array elements in WinCC 

Control system WinCC configuration 
Tag [A1, A2] C_GD4:u1,c"x", (A1*A2)-1 

● "x" stands for the number of the GUD in the DEF file. 

● "A1" stands for the maximum index of dimension 1. 

● "A2" stands for the maximum index of dimension 2. 

For additional information on converting or linearizing GUD arrays, please refer to the 
following chapters: 

● Linearization based on the sorting in SINUMERIK Operate (Page 70) 

● Converting a three-dimensional GUD array for linear access (Page 71) 

Example 
Linearizing a two-dimensional array, e.g. [2,3] looks like this: 

Table 6- 4 Example for the linearization of a two-dimensional index' 

Two-dimensional index in the NC One-dimensional index in WinCC 
0 0 0 
0 1 1 
0 2 2 
1 0 3 
1 1 4 
1 2 5 

The example is two-dimensional and has three elements in each dimension. 

 

Table 6- 5 Example for addressing array elements in WinCC 

Control system WinCC configuration 

REALGUD[0,0] C_GD4:u1,c"x",0 
REALGUD[0,1] C_GD4:u1,c"x",1 
REALGUD[0,2] C_GD4:u1,c"x",2 
REALGUD[1,0] C_GD4:u1,c"x",3 
REALGUD[1,1] C_GD4:u1,c"x",4 
REALGUD[1,2] C_GD4:u1,c"x",5 

● GUD definition: DEF {NCK|CHAN} type Name[number of lines, number of columns] 

● "x" stands for the number of the GUD in the DEF file. 
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6.3.2.2 Linearization based on the sorting in SINUMERIK Operate 
Independent of whether an array is two or three dimensional, you can linearize the sorting in 
SINUMERIK Operate. 

Open a GUD array in SINUMERIK Operate under "Parameter > User tags > Global GUD > 
GUD selection". 

● The uppermost element [0,0] is addressed with index=0. 

● The uppermost element [0,1] is addressed with index=1. 

● etc. until the lowest or last element, which is addressed with MaxIndex. 

 
Figure 6-3  Screen "Global GUD > GUD selection" in SINUMERIK Operate: The selected tag is addressed using index=0, 
the tag below, using index=1 etc. 
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6.3.2.3 Converting a three-dimensional GUD array for linear access 
The following diagram shows you the linearization of a three-dimensional array. You can find 
the linearized numbering to a three-dimensional array at the left in the corresponding table 
cell of the table to the right, e.g. (2,1,1) = (22). 

The linearization of a two-dimensional GUD array is also included in it: One page of a three-
dimensional array corresponds to one page of a two-dimensional array, whereby the side 
index is eliminated, e.g. (0,1,2) = (1,2). 

 
Figure 6-4  Linearization of three dimensional arrays 

Information about the conversion 

● Access, three-dimensional array: 
Array[page;line;column] 

● Conversion to linearized numbering: 
Array index linear = (number of lines*number of columns) * page index   +  number of 
columns * line index   +   column index 

● Access linearized array: 
Array[Arrayindexlinear] 

 

In the prevailing 3x3x3 array, the following applies for the conversion: 

Number of lines = 3 

Number of columns = 3 

 

The indices can only have the values 0, 1 or 2: 

Permissible values, page index are: {0|1|2} 

Permissible values, line index are: {0|1|2} 

Permissible values, column index are: {0|1|2} 
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6.3.2.4 Accessing GUD arrays using an index tag 
In the "HMI tags" editor, if you insert a new tag as GUD array, then as a default setting, the 
array length (parameter "Field number") is entered to permanently access an individual array 
element (e.g. Field number=9). 

In order to be able to dynamically access individual elements of the GUD array using an 
index tag that you have created yourself, you must make the following settings in the 
Address column in the editor: 

● "Field number" parameter: Change the default value here to "1", so that you can 
configure the "Line" parameter with an index tag. 

● "Line" parameter: Select the previously created index tag (from the diagram,"Idx"). 

 
Figure 6-5 Parameters completed as example when using index tags for addressing 
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6.3.3 Importing GUD tags 

6.3.3.1 Overview 
The user data (GUD) is made available to WinCC on the configuration PC in the following 
way: the user data is packed in a user database using the supplied "WinCC import NC 
userdata" GUD tool and then stored with the corresponding TIA Portal project. 

 

 Note 
Data consistency between the TIA Portal and SINUMERIK Operate 

If you change something in the data in SINUMERIK Operate after the import into the TIA 
portal, these changes are not automatically synchronized between the systems. 

Repeat the import process, therefore, if you change something in the GUD data in 
SINUMERIK Operate. 

 

 Note 
GUD tags not compatible with libraries 

GUD tags are not compatible with libraries and are not stored in a library when you copy a 
configuration. 

 

Procedure overview 
To use GUD in the TIA Portal, proceed as follows: 

 
Step Description 
1 Provide the NC data as DEF files. To do this, you have the following options: 

• Using SINUMERIK Operate, export any existing DEF files from the NCU and copy them to the configuration 
PC. 
See Copying GUD to the configuration PC (Page 74). 

• Create new DEF files directly on the configuration PC. 

2 Create a GUD database using the GUD TOOL "WinCC import NC userdata". 
See Creating a user database for global user data (Page 75). 

3 The symbolic name is not included in the project when GUD tags are imported. 
Open the "HMI Tags" editor and enter the tag names of the imported GUD tags. 

Result 
The GUD tags have been imported, and can be selected in the "Address" field of the NC 
connection in the "HMI Tags" editor. 

If you have specified the tag name in the "HMI Tags" editor, you can address the tags using 
their symbolic names. 

To modify the GUD later, you need to create a new user database. See also: Subsequently 
changing definition files (Page 77). 



Configuring variables  
6.4 Configuring a tag for address multiplexing 

 SINUMERIK Integrate Create MyHMI /WinCC V13 
74 Configuration Manual, 02/2014 

6.3.3.2 Copying GUD to the configuration PC 
The following describes the basic procedure for copying the DEF files from the NCU. 

Requirement 
● In SINUMERIK Operate, the USB port is enabled under "Commissioning > HMI > 

Log.Drive." 

● A USB flash drive is plugged in. 

Procedure 
To make the GUD on the NCU available to the TIA Portal, proceed as follows: 

1. Select the "Definitions" directory from the SINUMERIK Operate user interface in the 
operating area "Commissioning > System data > NC data", and press the "Copy" softkey. 

The "Definitions" directory is copied to the clipboard with all DEF files. 

2. Select the USB flash drive in the folder structure, then press the "Paste" softkey. 

The "Definitions" directory is copied to the USB flash drive. 
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6.3.3.3 Creating a user database for global user data 

Requirement 
● The current DEF files from the NCU are available on the PG/PC. 

● The TIA Portal project in which the GUD tags are to be used has been created but it is 
closed. 

Procedure 
To make the DEF files of the NCU available to the TIA Portal project and to create a user 
database, follow these steps: 

1. On the PG/PC, select "Programs > Siemens Automation > SINUMERIK > GUD Tool" in 
the Windows Start menu. 

"WinCC import NC userdata" GUD tool starts. 

 
Figure 6-6 "WinCC import NC userdata" GUD tool 

2. In the "TIA Portal project selection" input box, select the project (*.ap* file) in which the 
generated user database and the GUD user definition files should be saved. 

3. In the "GUD definition files" input box, select the directory that contains the GUD user 
definition files. For example, this could be a USB flash drive with the copied DEF files 
(MGUD.DEF, UGUD.DEF, GUD4.DEF, GUD5.DEF, etc.) of the NC. 

4. Click "Start". 
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Result 
The files are copied to the project and a user database is created. 

● The Userdata.mdb file is created in the <project>\IM\HMI\Sinumerik\Databases directory. 

● The GUD user definition files are copied into the <project>\IM\HMI\Sinumerik\Userdata 
directory. 

In the HMI Tags editor, the GUD tags are available in the selection dialog of the "Address" 
column under "GUD: dynamic user data". 

 
Figure 6-7 Selection of GUD tags 
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6.3.4 Subsequently changing definition files 
If definition files are changed, the database must be re-created using the "WinCC import NC 
userdata" GUD tool.  

If a new data item must be included in a definition file, then we recommend that this data 
item is attached to the end of the file. The addressing of the previous data item therefore 
remains unchanged. The already existing HMI tags remain correctly addressed. 

If a data item must be inserted in existing GUD, this changes the addressing of the 
subsequent data. As a consequence, the runtime would access incorrect data. To prevent 
this, already configured HMI tags must be configured to the data "shifted" into the definition 
file using the variable editor. 

If existing data is changed, after updating the database, the modified data must be opened in 
the WinCC variable editor using the "WinCC import NC userdata" GUD tool and possibly 
corrected. 

Check the usage of the modified variables (e.g. data type) in the I/O field. 

6.3.5 Copying GUD to NCU 
If you have expanded the GUD tags offline in the TIA Portal, you must copy the changed 
DEF files with SINUMERIK Operate back to the NCU. 

The DEF files of the GUD database used in the TIA Portal must match the DEF files in the 
NC so that the WinCC RT Advanced Runtime can correctly access the GUD tags. 

Procedure 
To copy the GUD from the configuration PC to the NCU, proceed as follows: 

1. On the configuration PC, copy the DEF files from the project folder to a USB flash drive.  
The DEF files are located in the following directory: \<Project 
folder>\IM\HMI\Sinumerik\Userdata\ 

2. In the SINUMERIK Operate user interface, in the operating area "Commissioning > 
System data > NC data", copy the files from the USB flash drive into the "Definitions" 
directory. 

3. Activate the files using "Define and activate user files (GUD)". 
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6.4 Configuring a tag for address multiplexing 

Introduction 
Using address multiplexing, you can use a single variable to access a multitude of memory 
locations within the PLC's address range. You read and write to the addresses without 
defining a variable for each individual address. This efficient method allows you to process a 
large amount of data. 

Example of a procedure using R parameters as a basis 
1. Create a local "index" variable. 

2. Create a variable with a connection to a control, and in area C and in the RP block, select 
the R parameter variable. 

3. You can make a selection from the operator control to the right next to the input for the 
parameter number. 

4. Select HMI_variable followed by the "index" variable. 

 
Figure 6-8 Address multiplexing 

Result 
By changing the "index" variable during the runtime, another R parameter is accessed. 
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 Configuring alarms 7 
7.1 Overview 

Introduction 
You can view both HMI alarms as well as SINUMERIK-specific alarms in the WinCC control 
"Alarm view" at runtime: 

● NC alarms 

– To display NC alarms in the alarm view, you must configure the settings (Page 80). 

– You can customize the displayed alarm texts directly on the configuration PC 
(Page 82). 

● DB2 alarms from the PLC (alarm numbers 500000 to 799999) 

– You can import DB2 alarms from the NCU (Page 84). 

● SIMATIC PLC alarms 

– HMI alarms defined in WinCC are displayed in the alarm view in each case. 
You can find information on configuration in the information system of the TIA Portal, 
section "Visualizing processes > Working with alarms > Configuring alarms". 

Additional information 
This section describes what you need to consider when configuring the SINUMERIK-specific 
alarms / messages. 

You can find general information on configuring alarms / messages in WinCC in the 
information system of the TIA Portal, section "Visualizing processes > Working with alarms". 
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7.2 Configuring NC alarms 

7.2.1 Settings for display of NC alarms 

Requirements 
To display NC alarms in the alarm view at runtime, the following requirements must be met: 

● A connection to the NC is configured. 
See Configuring a non-integrated connection (Page 57). 

● The SINUMERIK alarm classes are activated. 
These settings can be found in the project tree in the runtime settings under "Alarms". 
The following settings for the connection to the NC must be made in the PLC alarms 
table: 

– NC alarms: Texts and figures 

– NC events: Activated 

 
Figure 7-1 Settings for PLC alarms of the connection (the name of the connection is "nc" in the screen)  
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● The SINUMERIK alarm classes "NC alarms" and "NC events" are activated in the 
properties of the "Alarm view" control. 

 
Figure 7-2 Alarm classes in the properties of the "Alarm view" control 
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7.2.2 Changing NC alarm texts 
The NC alarm texts are stored on the configuration PC during installation of SINUMERIK 
Integrate Create MyHMI /WinCC. Here, the familiar weighting concept of SINUMERIK is 
used with the Siemens, OEM and User folders. 

When you adapt the alarm text, read the information about file storage, the weighting 
concept and character set in this section. 

Storing 
NC alarm templates are saved in the following directory on the configuration PC during 
installation of the TIA Portal: 

● <Installation directory of the TIA Portal>\Data\Hmi\Sinumerik\Alarmtexts 

● For example: 
C:\Program Files (x86)\Siemens\Automation\Portal V13\Data\Hmi\Sinumerik\Alarmtexts\ 

 

 Note 
Using original files for the NC alarm text only as template 

To avoid losing the original files of the NC alarm texts, copy them to the user directory before 
you change them. 

 

The SINUMERIK alarm texts stored in the installation directory serve as template. 

If you only want to modify texts, copy the corresponding alarm directory to the directory of 
the relevant TIA Portal project:  

● <Project directory>\IM\HMI\Sinumerik\Alarmtexts 

● For example: 
C:\Users\Admin\Documents\Automation\My_Project\IM\HMI\Sinumerik\Alarmtexts 

At this point in the project, alarm texts can now be changed.  

We recommend that the original texts are kept in the "Siemens" directory and changes are 
only made in a copy located in the "OEM" or "User" directories. 

Weighting concept 
The alarm texts are read line-by-line in the following order: 

1. Siemens 

2. OEM 

3. User 

Which means a changed alarm text in the OEM directory overrides the alarm text in the 
Siemens directory. 

A changed alarm text in the User directory in turn overrides the alarm text in the OEM or 
Siemens directories. 
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Character set and encoding 
When you adapt the alarm texts, pay attention to the character set used (e.g. ANSI) and the 
encoding. Do not use any characters or any text editors which are not compatible with the 
character set or encoding. 

The respective alarm text file indicates the character set used. 

ANSI in conjunction with GB2312 (Chinese simplified) encoding is used for Chinese alarm 
texts. 
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7.3 Configuring DB2 alarms 

7.3.1 Overview 
The PLC alarms in the number range 500000 to 799999 are be configured via program 
blocks of the PLC basic program:  

● A bit is set or deleted in the ALMSG_DB [DB2] program block. 

● The program block AL_MSG[FC10] checks the program block [ALMSG_DB2] for this bit. 

● An alarm is displayed or not displayed depending on this bit in the program block 
ALMSG_DB [DB2]. 

The alarms are referred to as DB2 alarms, for example, from SIMATIC PLC alarms. 
See also: Configuring alarms (Page 79) 

In the basic program, cyclically call the AL_MSG [FC10] program block, which checks 
program block ALMSG_DB [DB2] for coming and going alarms. 

In SINUMERIK Operate you can assign these alarms language-dependent alarm texts. 

You can import these DB2 alarm texts into the TIA Portal. 
 

 Note 
Data consistency between the TIA Portal and SINUMERIK Operate 

If you change something in the data in SINUMERIK Operate after the import, these changes 
are not automatically synchronized between the systems. 

Repeat the import process, therefore, if you change something in the data in SINUMERIK 
Operate. 

 

 Note 
DB2 alarms not compatible with libraries 

DB2 tags are not compatible with libraries and are not stored in a library when you copy a 
configuration. 

 

Additional information 
Information about "FC 10: AL_MSG errors and operating messages" are listed in the 
SINUMERIK 840D sl/828D Basic Functions Function Manual in Chapter "P3: PLC basic 
program for SINUMERIK 840D sl". 
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Precondition 
● The SINUMERIK 840D sl TIA Portal Toolbox is installed. 

(Required to configure a SINUMERIK NCU) 

● An NCU has been added. 

● A PC system with WinCC RT Advanced or a SIMATIC Panel has been added. 
See Inserting PC system and Runtime (Page 42) or Adding a SIMATIC Panel (Page 49) 

● A connection to the PLC is configured. 
See Configuring connections (Page 53) 

● SINUMERIK Integrate Access MyMachine /P2P is installed. 

See Overview of TOOLS supplied (Page 15) 

Procedure overview 
To read DB2 alarms from the PCU 50.5 (or NCU) and import them into the TIA Portal, follow 
these steps: 

 
Step Description 
1 Make the DB2 alarms available as TS files in the corresponding language. The following options are available: 

• If you have installed SINUMERIK Integrate Access MyMachine /P2P on a PG/PC, using SINUMERIK Operate 
copy the TS files to a USB flash drive (Page 88). 

• If you have installed SINUMERIK Operate and SINUMERIK Integrate Access MyMachine /P2P on the same 
PC system, then you will find the TS files in the following directory: 

C:\Program Files (x86)\Siemens\MotionControl\oem\Sinumerik\hmi\lng\ 
• You can learn how to export the files and simultaneously convert them with an online connection in the online 

help for SINUMERIK Integrate Access MyMachine /P2P in the section "Exporting a file". 

2 Convert DB2 alarms using SINUMERIK Integrate Access MyMachine /P2P into the CSV format (Page 89). 
3 Check that all languages in which you want to import DB2 alarms are enabled as project languages in the TIA 

Portal. 
• To learn which exported CSV files correspond to specific project languages in the TIA Portal, refer to the 

section Language assignment in language-dependent texts (Page 122). 
• How to enable the project languages is described in the section Enable project languages (Page 118). 

4 Import the CSV files into the TIA Portal (Page 92). 

Result 
The imported DB2 alarms appear in two different editors in the TIA Portal: 

● Below the WinCC RT Advanced or the SIMATIC panel in the "HMI messages" editor, 
"Controller alarms" tab. 

● Below the PLC in the "PLC messages" editor. 

You can now configure the "Alarm view" control in the screen. In order that the imported 
alarms are displayed during the runtime, adapt the settings to display DB2 alarms (Page 86). 
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7.3.2 Settings for displaying DB2 alarms 

Preconditions 
To display DB2 alarms in the alarm view at runtime, the following requirements must be met: 

● A connection has been configured to the PLC. 
See Configuring connections (Page 53). 

● System messages are activated. 
These settings can be found in the project tree in the runtime settings under "Messages". 
The following option boxes must be activated in the "System messages" section: 

– S7 diagnostic messages (number) 

– Display message text 

 
Figure 7-3 Settings to display DB2 alarms 
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● In the properties of the control "Alarm view" in the option box "Message buffer", the 
message classes are activated. 

 
Figure 7-4 Message classes in the properties of the control "Alarm view" under "Message buffer" 
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7.3.3 Exporting DB2 alarms (TS files) 
This chapter describes how you export the DB2 alarms using the user interface of 
SINUMERIK Operate. 

Alternatively, you can also copy DB2 alarms in a different way; you can also export these in 
one step and convert them using SINUMERIK Integrate Access MyMachine /P2P if an online 
connection exists.  

● When installing SINUMERIK Operate on a PC system, DB2 alarms are saved on a PC 
system in the TS format at the following memory location: 

C:\Program Files (x86)\Siemens\MotionControl\oem\Sinumerik\hmi\lng\ 

● You can learn how to export the files and simultaneously convert them with an online 
connection in the online help for SINUMERIK Integrate Access MyMachine /P2P in the 
section "Exporting a file". 

Precondition 
● A USB flash drive is inserted at a PC system with SINUMERIK Operate. 

● In SINUMERIK Operate, the USB port is activated under "Commissioning > HMI > Log. 
Drive." 

Procedure 
To copy TS files from SINUMERIK Operate, and to convert them into the CSV format using 
SINUMERIK Integrate Access MyMachine /P2P, proceed as follows: 

1. In SINUMERIK Operate select the screen "Commissioning > System data" – and in the 
folder structure, navigate in the "HMI data/Texts/Manufacturer/" directory. 

2. Select the required TS files and actuate the "Copy" softkey". 

3. Select the directory structure of your USB flash drive and press the "Paste" softkey. 

Result 
The DB2 alarms were copied from SINUMERIK Operate as TS files. 
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7.3.4 Converting DB2 alarms into the CSV format 
 

Precondition 
● The USB flash drive with copied TS files is inserted and/or the TS files are available 

elsewhere. 

● SINUMERIK Integrate Access MyMachine /P2P is installed 
See Overview of TOOLS supplied (Page 15) 

Procedure 
To copy TS files from SINUMERIK Operate, and to convert them into the CSV format using 
SINUMERIK Integrate Access MyMachine /P2P, proceed as follows: 

1. Start Access MyMachine /P2P, e.g. using the entry in the start menu: 
"Start > All programs > SINUMERIK > Tools > Access MyMachine P2P (PC)" 
SINUMERIK Integrate Access MyMachine /P2P is opened. 

 
  Note 

Settings to be made when starting for the first time 

If you are starting the tool for the first time, you must assign a password and when 
necessary, make connection settings. 

Additional information on this is provided in the online help for Access MyMachine /P2P. 
 

2. Click in the menu "File" on "New > Project...", enter the project properties and confirm 
with "Save". 
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3. Click in the "Project" area on "Add...". 

 
Figure 7-5 SINUMERIK Integrate Access MyMachine /P2P 
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4. In the "Open" dialog, navigate to the USB flash drive with the copied TS files, select them 
and click "Open." 
The TS files are displayed in the "Project" area in the tree structure below the associated 
language. 

 
Figure 7-6 Project area with added TS files 

5. Select the check box for the TS files you want to use in the TIA Portal, click "Export" and 
select a folder where the CSV files are to be stored. 

Result 
The DB2 alarms were converted using Access MyMachine /P2P into the CSV format. 

You can import (Page 92) these CSV files into the TIA Portal. 



Configuring alarms  
7.3 Configuring DB2 alarms 

 SINUMERIK Integrate Create MyHMI /WinCC V13 
92 Configuration Manual, 02/2014 

7.3.5 Importing DB2 alarms 

Precondition 
● The SINUMERIK 840D sl TIA Portal Toolbox is installed. 

(Required to configure a SINUMERIK NCU) 

● An NCU has been added. 

● A PC system with WinCC RT Advanced or a SIMATIC Panel has been added. 
See Inserting PC system and Runtime (Page 42) or Adding a SIMATIC Panel (Page 49) 

● An integrated connection to the PLC has been created. 
See Configuring connections (Page 53) 

● The DB2 alarm texts of the corresponding language are available in CSV format. 
See Overview of TOOLS supplied (Page 15) 

● The languages in which the CSV file are available are activated as the project language. 
See Language assignment in language-dependent texts (Page 122) and Enable project 
languages (Page 118) 
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Procedure 
To import DB2 alarm texts in the CSV format into the TIA Portal, follow these steps: 

1. In the project tree, right-click on the integrated PLC or NCU, then, select "Import DB2 
alarms" in the shortcut menu. 

 
Figure 7-7 Importing DB2 alarms 

2. Click on button "...", change into the directory with the CSV files and select all of the 
required files, e.g. using the mouse. 

 
Figure 7-8 Opening DB2 alarms 
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3. Confirm the selection with "Open". 
In the "Import DB2 alarms" dialog, the selected files are displayed, separated by a 
comma. 

 
Figure 7-9 "Import DB2 alarms" dialog with two selected CSV files 

4. Click on the "Import" button. 

Result 
The DB2 alarms have been imported and are displayed in the TIA Portal in two different 
editors: 

● Below the PLC in the "PLC messages" editor. 

● Below the WinCC RT Advanced or the SIMATIC panel in the "HMI messages" editor, 
"Controller alarms" tab. 

 
Figure 7-10 Imported DB2 alarms in the HMI messages editor 
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You can now configure the "Alarm view" control in the screen. In order that the imported 
alarms are displayed during the runtime, adapt the settings to display DB2 alarms (Page 86). 

See also 
SINUMERIK Integrate Access MyMachine /P2P in the SIEMENS Industry Mall 
(https://ebstage.automation.siemens.com/mall/en/us/Catalog/Products/10166235) 

https://ebstage.automation.siemens.com/mall/en/us/Catalog/Products/10166235
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 Configuring screen objects 8 
8.1 Overview 

Overview 
Once you have planned and implemented the structure and number of screens in your 
configuration, you can add screen objects in the required screens. 

In addition to the standard range of screen objects in SIMATIC WinCC Advanced, you can 
configure the "NC program part" control: 

● Configuration and operation (Page 98) 

● Properties (Page 100) 

● Change via script (Page 102) 

Additional information 
You can find information about the standard range of screen objects of SIMATIC WinCC 
Advanced in the information system of the TIA Portal: 

● section "Visualizing processes > Working with Objects". 
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8.2 "NC part program" display object 

Introduction 
The "NC part program" display object allows you at runtime to display and select part 
programs, subprograms or workpieces as overview.  

The display object can be found in the Task Card "Tools" below "Controls". 

Configuration options 

To make the part program overview functionally complete, you can configure function keys 
or configured command buttons with NC part program functions (e.g. navigating and 
selecting in the list directory). 

You can specify the properties of the display objects during the configuring, e.g. what font it 
should have. See also: Properties of the "NC part program" display object (Page 100) 
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Operation of the "NC part program" display object at runtime 
The following figure shows the "NC part program" display object during configuration. 

 
Figure 8-1 "NC part program" display object 

During the runtime, command buttons can be used to: 

Table 8- 1 Command buttons for the display object 

Element Function 
Current path name The path of the opened directory is displayed, e.g. MPF, SPF. 
List box below "Current path name" Part program names and directories are displayed line-by-line 

in the list. 
Select in the list box the directory to be opened or the required 
program. 

 
Navigating and selecting in the list directory 

 
Update directories in the list box 

 
Select the selected part program / workpiece on the NC for 
editing. 

Selected channel Enter the NC channel as integer in the "Selected channel" text 
box. 

Click or touch a directory name to change to the selected directory. The new path name is 
displayed below the "Current path name" and the subdirectories are displayed in the list box. 
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8.3 Properties of the "NC part program" display object 

Introduction 
You have several ways of configuring the "NC part program" display object in the "Screens" 
editor. These selection options are available for a selected display object in the Inspector 
window below Properties. 

 
Figure 8-2 Properties of the "NC part program" display object 
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General properties 
Under "General", you can make the following settings for part program selection: 

 
Property Description 

Connection > Name Select the NC control using its symbolic name. 
Path > Name Select a predefined path name (max. 29 characters, in uppercase 

letters). For example, WKS_DIR, MPF_DIR, SPF_DIR, CST_DIR, 
CUS_DIR or CMA_DIR. 

Path > Variable Select the connected path variable. 
Channel > Name Select one of the predefined channels (1 - 10). 
Channel > Variable Select the connected channel variable. 
Channel > Editable 
Path > Editable 

You can enable/disable editing of the paths or channels by 
selecting the "Editable" field. 

Additional properties 
You can customize the complete representation of the "NC part program" display object 
using Design, Layout, Representation, Text, Flashing and Miscellaneous. 

Further information concerning the properties of WinCC display objects 

Information concerning the properties for WinCC display objects can be found in the 
information system of the TIA portal. This contains not only detailed descriptions, but also 
Tooltips directly for the individual properties. 

"Layout" property 

You can select which buttons, etc. should be displayed in the display object under "Layout". 

Events 
In order to also be able to operate the "NC part program" externally or, depending on the 
functionality, to allocate an appropriate authorization, command buttons can be hidden in the 
display object during the configuration. The required functionality can be triggered via 
softkeys with various authorization levels. 

If you have selected the "NC part program" display object, you can configure functions for 
Events in the Inspector window using "Properties > Events". 

Table 8- 2 Events for the "NC part program" display object 

Event Meaning 
Enable On selection, the display object is activated. 
Deactivation On deselection, the display object is deactivated. 

Further information 

Information about the configurable functions of the "NC part program" display object are 
contained in Section Configuring PI services of the NC as system functions (Page 103). 
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8.4 Changing the display object using a script in WinCC 

Changing the display object using a script in WinCC 
You can also modify display object properties at runtime in WinCC using scripts. This 
provides a means, for example, of changing the colors or the part program path dynamically. 

Script example 
Dim view 

Set view = HmiRuntime.Screens("Screen_1").ScreenItems("NC Part Program_1") 

view.Channel=1 

view.BackColor=RGB(0, 255, 0) 

view.GridlineColor=RGB(0, 0, 255) 

view.Path="MPF_DIR" 

 



 

SINUMERIK Integrate Create MyHMI /WinCC V13 
Configuration Manual, 02/2014 103 

 Configuring PI services of the NC as system 
functions 9 
9.1 Overview 

Purpose 
In WinCC, you can link events (e.g. "Key pressed") with predefined functions. If an event 
should occur during operation, the function triggers a certain action on the HMI device or in 
the control. 

Principle 
In general, you can use the functions for the following: 

● Establish the configuration on a process-for-process basis (e.g. branch from one screen 
to another). 

● Control the process (e.g. set control parameters). 

● Carry out the system settings online at the HMI device (e.g. changing interface 
parameters). 

As a rule, functions and events are linked to a certain object. For example, a function with 
event "Press key" is not triggered by every key, but only by one specific key. 

Objects, which can be linked to functions, include: 

● Function keys and command buttons 

● Fields 

● Screens 

● Tags 

The number of functions offered is, therefore, dependent on the HMI device and on the 
situation. 
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SINUMERIK functions 
In addition to the functions available in WinCC, SINUMERIK-specific functions (PI services) 
are provided to support configuration with SINUMERIK Integrate Create MyHMI /WinCC. 

These are the following functions: 

● Functions for the "NC part program" display object (Page 105) 

● Function for the current block display (Page 107) 

● Function to start and stop the PLC (Page 109) 

Further information 

Information about general functions for WinCC can be found in the information system of the 
TIA portal. This contains not only detailed descriptions, but also Tooltips directly for the 
individual functions. 



 Configuring PI services of the NC as system functions 
 9.5 Running NC functions from WinCC 

SINUMERIK Integrate Create MyHMI /WinCC V13 
Configuration Manual, 02/2014 105 

9.2 Functions for the "NC part program" display object 

Introduction 
In order to also be able to operate the "NC part program" externally or, depending on the 
functionality, to allocate an appropriate authorization, command buttons can be hidden in the 
display object during the configuration. The required functionality can be triggered via 
softkeys with various authorization levels.  

Procedure 
To add a new function, proceed as follows: 

1. Open the editor for screens. 

2. Select the "NC part program" display object. 

3. In the inspector window, switch to "Properties > Events". 

4. To add a new function, select it from the "<Add function>" dropdown list in the "keyboard 
operation for display objects" directory. 

 
Figure 9-1 "Keyboard operation for display objects" functions 
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Functions available for the "NC part program" display object 
The following functions influence the "NC part program" display object: 

Table 9- 1 Functions for the NC part program display object 

Function Meaning 
ScreenObjectCursorDown Performs the <down> key function on the the 

specified display object. 
ScreenObjectCursorUp Performs the <up> key function on the the 

specified display object. 
ScreenObjectPageDown Performs the <page down> key function on the 

the specified display object. 
ScreenObjectPageUp Performs the <page up> key function on the the 

specified display object. 
PartProgramListDirDown Navigate and select in the list directory. 
PartProgramListDirUp Navigate and select in the list directory. 
PartProgramListRefresh Update directories in the list box 
PartProgramListSelectNCPartProgram Open the selected part program for editing on the 

NC. 
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9.3 Function for the current block display 
The PrepareActualNCBlockForDisplay function is used to monitor the execution of the 
traversing blocks of an NC traversing program on the HMI device. This function is used to 
save the current, previous and next traversing block of an NC part program currently being 
processed in a channel from the NC to local variables. 

Procedure on the HMI device 

● The PrepareActualNCBlockForDisplay function starts when a screen is opened. 

● A non-configured NC tag block is activated with the configured cycle. 

● On each cyclic reading operation of the NC tag block, the tag block is divided into three 
parts and stored in the local tags of the previous, current and subsequent set. 

● The local variables can be displayed on the screen as outputs. 

Procedure 
1. Select the function in the screen editor for "Select screen" (the screen is selected) from 

"Events > Structured > Add function" in the "SINUMERIK" directory. 

 
Figure 9-2 Current block display 

2. Specify three local tags of type String of length 66. 

3. Within a screen, create three output fields each with one of these tags. 
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4. Now configure the PrepareActualNCBlockForDisplay function as the open screen trigger. 

5. Then specify the corresponding NC, the channel from which the current block is to be 
read, the cycle, and the three local string tags as parameters for this function. 

 

Parameter Meaning Data type 
Connection Name of the NC. 

Can be viewed under: "PC-
System_1 > HMI_RT_1 > 
Connections". 

ASCII characters 

Channel Channel from which the program 
is to be read; 1 - max. 10 

Constant or variable 

Cycles (100 ms) Update time as a multiple of 100 
ms: 1 – 600 (equal to 100 
milliseconds – 1 minute) 

Constant 

Previous block (output) Local tag for the traversing block 
that precedes the current 
traversing block 

String tag 

Current block (output) Local tag for the current 
traversing block 

String tag 

Next block (output) Local tag for the traversing block 
that follows the current block 

String tag 
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9.4 Function to start and stop the PLC 

Introduction 
This function changes the operating mode of an S7-CPU: RUN or STOP. 

Procedure 
1. Select the function in the screen editor with "Events > Add functions > Settings". 

 
Figure 9-3 SetS7OperatingMode 

2. Assign the SetS7OperatingMode function to a key of the screen. 

3. Enter the required parameters: 

 

Parameter Meaning 
Connection Symbolic name of the S7-CPU, which you entered 

under the "Properties" of the control. 
Operating mode Operating mode of the S7 CPU  

(variable or constant):  
0 = RUN 
1 = STOP 
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9.5 Running NC functions from WinCC 

9.5.1 Overview 

Requirement 
A connection to the NC is established. 

See: Configuring a non-integrated connection (Page 57) 

Procedure 
To add a new function, proceed as follows: 

1. Open the editor for screens. 

2. In the Inspector window, switch to "Properties > Events". 

3. To add a new function, select it from the "<Add function>" drop-down list in the 
"SINUMERIK" directory. 

 
Figure 9-4 "SINUMERIK" functions 

The following functions are available: 

– LogoffNC (Page 111) 

– ChangeNCPassword (Page 111) 

– LogonNC (Page 112) 

– ConfigureNCMachineData (Page 112) 

– ResetNC (Page 112) 

– AcknowledgeNCCancelAlarms (Page 113) 

– SetNCUserFrame (Page 113) 

– StartNCPIService (Page 114) 

– SelectNCPartProgram (Page 115) 
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9.5.2 LogoffNC 

Description 
This function clears the NC password. Following this, the keylock switch acts. 

The passwords for the HMI device and the NC are independent of one another. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 

9.5.3 ChangeNCPassword 

Description 
A password is passed to the NC for a password level. The existing password for this 
password level is overwritten. 

The user must be logged on to the NC with a suitable access level (level). 

Procedure on the HMI device 

The currently valid NC password is overwritten by the new password. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
Password New PLC password (max. 8 characters)  

(constant or variable) 
Level NC password level  

(constant or variable):  
0 = system 
1 = manufacturer 
2 = service 
3 = user 
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9.5.4 LogonNC 

Description 
A password is passed on to the NC. The passwords for the HMI device and the NC are 
independent of one another. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
Password The password that authorizes the NC logon (variable or constant) 

Procedure on the HMI device 

After activating the function, the specified password is used to attempt to log on to the NC. 

9.5.5 ConfigureNCMachineData 

Description 
This function is used to activate all machine data of NEW_CONF classification. 
The CLASS parameter permits a more detailed classification. Currently, however, only value 
1 is supported. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
Class Classification of the machine data being activated (variable or constant): 1 - 3 

Procedure on the HMI device 

A corresponding PI service is transferred to the NC from the currently valid parameters.  

9.5.6 ResetNC 

Description 
This function triggers a restart at the NC. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
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9.5.7 AcknowledgeNCCancelAlarms 

Description 
This function is used to acknowledge all cancel alarms pending for the specified connection 
in a single action. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 

9.5.8 SetNCUserFrame 

Description 
The data for zero point offsets is activated for a channel. 

On entry, these variables are initially stored in a temporary memory on the NC. The 
SetNCUserFrame function completely activates the newly-entered values and can be read 
subsequently. 

With this PI service, only one zero offset can be activated. When several zero offsets are set, 
only the parameters of the zero offset last set can be activated. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
Channel Channel to be activated (constant or variable): 1 - max 10 

Procedure on the HMI device 

After the HMI device user has entered the data for the zero offsets into the HMI device and 
pressed the configured key, the zero offset data is activated for the specified channel. 
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9.5.9 StartNCPIService 

Description 
This function can be used to transfer any PI service to the NC. This must be described by a 
parameter string. This parameter string must include the full command and not merely the 
parameters of the PI service. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
PI parameter string Specification of the PI service to run  

(constant or variable) 
Result (output) When a function is activated, a return value is reported in this 

parameter asynchronously after termination. 

Procedure on the HMI device 

A corresponding PI service is transferred to the NC from the currently valid PI parameter 
string.  

Example 
NCK-Reset parameter string 

StartNCPIService 

("PI_START(/NC,K00,0,_N_IBN_SS)") 

 

Additional information 
You can find information on PI services in the online help "Help for PI services for 
SINUMERIK 810D, 840D, FM-NC" in the following directories: 

● <Installation directory of the TIA Portal>\Help\en-EN\pi-enEN.chm 
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9.5.10 SelectNCPartProgram 

Description 
You may implement some functions of part programs with the "NC program part" control. 
You can use the "SelectNCPartProgram" function to select all part programs via the NCU 
domain services. 

For example, this allows you to create special screens for permanently-defined part 
programs. These screens can then support a simplified selection process using buttons. 

 
Parameter Meaning 
Connection Name of the connection to the NC. 
Channel Channel, for which the program is selected: 1 – max. 10 

(variable or constant) 
Path name Absolute path details for the program directory  

(variable or constant) 
Program name The name of the program or workpiece to be edited (variable or constant) 

 

 

 Note 

Together, the path name and program name parameters must indicate the part program 
path. 

Enter only the absolute program or path name. 

Path name examples: 
• MPF_DIR for main directory 
• SPF_DIR for subdirectory 
• WKS_DIR for workpiece program directory 

 

Procedure on the HMI device 

The specified part program is selected on the NC for editing. 
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Example 
The following example code is used to disable the "SelectPartProgram" button in the "NC 
program part" control. 

 
VBScript 
Sub Button_select_not_visable() 
'VBS_Example_ScreenItems 
Dim objNCpartprogram 
Set objNCpartprogram = HmiRuntime.Screens("Screen_1").ScreenItems("NC part program 
view_1") 
objNCpartprogram.ButtonSelectPartProgramVisible = False 
End Sub 

The "Keyboard operation for screen objects" function group with "PartProgramListRefresh", 
for example, is not enabled for scripts. 

9.6 System function calls within a script 

Introduction 
You can call the SINUMERIK system functions in WinCC even within a VBScript: 

● The English function names are used here. 

● In the "Connections" editor, you can see the name of your connection to the NC that you 
need as parameter in all functions. 

● You can find general information on using VBScripts in WinCC in the information system 
of the TIA Portal, section "Visualizing processes > Working with system functions and 
Runtime scripting (Panels, RT Advanced, RT Professional)". 

Example 
 
VBScript 
ResetNC "SinumerikNC" 

 SinumerikNC here represents the name that was selected for the connection to the NC. 

See also 
Appendix (Page 133) 



 

SINUMERIK Integrate Create MyHMI /WinCC V13 
Configuration Manual, 02/2014 117 

 Configure the language settings 10 
10.1 Overview 

You need to make various language settings depending on the scope of your configuration: 

● If you create your project for multiple languages, you need to set them as project 
languages (Page 118) and runtime languages. You also use the table for language 
mapping between SINUMERIK Operate and TIA Portal (Page 122) for this. 

● When using a PC system, you can make settings to synchronize the language switching 
between SINUMERIK Operate and WinCC RT Advanced (Page 119). 
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10.2 Enable project languages 

Introduction 
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language.  

Enable project languages 
1. Click on the arrow to the left of "Languages & resources" in the project tree. 

The lower-level elements will be displayed. 

2. Double-click on "Project languages". 

The possible project languages will be displayed in the working area. 

3. Enable the relevant project languages.  

 
  Note 

Copying multilingual objects 

The copies of multilingual objects to a different project only include text objects in the 
project languages which are activated in the target project. Activate all project languages 
in the target project to include the corresponding text objects when transferring the copy. 

 

Disabling project languages 
1. Disable the languages which are not relevant for the project.  

 

 
 NOTICE 

If you disable a project language, all text and graphic objects you have already created 
in this language will be deleted from the current project. 
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10.3 Configuring language selection (PC systems) 

Validity of the description 
This section relates to configuration with a PC system and does not apply to the 
configuration with SIMATIC Panels. 

Introduction 
You can automatically switch the language of WinCC RT Advanced Runtime when the 
language is changed in SINUMERIK Operate. However, it is not possible at this time to 
automatically apply the language in SINUMERIK Operate when the language is changed in 
the WinCC RT Advanced Runtime. Automatic language selection is currently only possible in 
one direction.  

To configure language selection, create an HMI tag with the address of the PLC data block 
DB10.DBB96 (Page 122) in which the active language of SINUMERIK Operate is stored. 
You then define a relation between the configured language order and the language in 
SINUMERIK Operate using a VB script and have the script be automatically executed when 
the value changes. 

Requirement 
● A project is created and a PC HMI device is added to the Runtime WinCC RT Advanced. 

See Inserting PC system and Runtime (Page 42) 

● The connection to the PLC and NC is configured. 
See Configuring connections (Page 53). 

● The project languages are set. 
See Enable project languages (Page 118) 

● The order of runtime languages is configured. 
See the information system of the TIA Portal, keyword "runtime language". 
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Procedure 
To switch to the language of WinCC RT Advanced Runtime based on the language set in 
SINUMERIK Operate, follow these steps: 

1. Double-click "Show all tags" in "PC System_1 > HMI_RT_1 > HMI tags" folder of the 
project tree. 

2. Create a new HMI tag with the following values: 

 

Column Value 
Name Can be freely selected (in the example below: 

"DB10DBB96") 
Tag table Default tag table 
Connection PLC 
Data type Byte 
Address %DB10.DBB96 

3. To create a new script, double-click "Add new VB function" in the "PC System_1 > 
HMI_RT_1 > Scripts > VB scripts" folder. 

4. In the Inspector window under "Properties > General", select "Sub" as the type and 
assign a name (in the example "LangFromOperate"). 
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5. Write a VB function according to the following scheme: 

Sub LangFromOperate() 
 
Select Case SmartTags("DB10DBB96") ' Selected Language in HMI Operate 
Case 1 'German - Germany 
 SetLanguage 0 ' "Order 0" in WinCC project Runtime settings 
Case 3 'English - United Kingdom 
 SetLanguage 1 ' "Order 1" in WinCC project Runtime settings 
Case 2 'French - France 
 SetLanguage 2 ' "Order 2" in WinCC project Runtime settings 
Case 6 'Italian - Italy 
 SetLanguage 3 ' "Order 3" in WinCC project Runtime settings 
Case 4 'Spanish - Spain (Traditional Sort) 
 SetLanguage 4 ' "Order 4" in WinCC project under Runtime settings 
Case 8 'Chinese - People's Republic of China 
 SetLanguage 5 ' "Order 5" in WinCC project under Runtime settings 
End Select 
 
End Sub 

 

Code Purpose 
Select Case SmartTags ("<HMI tag>") Evaluate the previously created HMI tag 

("DB10DBB96" in the example), which contains 
the value of the active language in SINUMERIK 
Operate. 

Case <n> Condition that checks the value of the HMI tag. 
Value <n> corresponds to the respective 
language value of DB10.DBB96, see table 
"Language values of DB10.DBB96" (Page 122). 

SetLanguage <n> Sets the language to the corresponding value 
<n> in Runtime. 
Value <n> is the number from the Order column 
in "PC System_1 > HMI_RT_1 > Runtime 
settings > Language & font". 

6. In the project tree, double-click on the previously created HMI tag. 

7. In the Inspector window under "Properties > Events", click on "Value change" in the area 
navigation, then click <Add function> and select the previously created VB function 
(LangFromOperate in the example). 

Result 
The language of WinCC RT Advanced Runtime is automatically switched when the language 
is changed in SINUMERIK Operate. 

However, it is not possible at this time to automatically apply the language in SINUMERIK 
Operate when the language is changed in the WinCC RT Advanced Runtime. Automatic 
language selection is currently only possible in one direction. 
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10.4 Language assignment in language-dependent texts 

Language ID in the file name of language-dependent texts 

Language-dependent texts are saved in TS files in SINUMERIK Operate. There is a 
separate file for each language which is assigned via the language ID in the file name. If you 
convert the DB2 alarms into the CSV format, this filename is kept, and the *.csv file 
extension added: 

● <Name><LanguageID>.ts.csv 

● For example: oem_alarms_plc_eng.ts.csv 

When you import the CSV file in the TIA Portal, it is mapped to a specific project language in 
the TIA Portal depending on the language ID in the file name. 

Storing the active language in DB10 

The language that is presently active in SINUMERIK Operate is saved in communication 
block DB10 in address DB10.DBB96 as value. 

Default languages in SINUMERIK Operate 

SINUMERIK Operate has six languages installed in the factory state. If you need additional 
languages, you can install them separately. 

Table 10- 1 Language assignment for language-dependent texts and language values in DB10 

Value in 
DB10.DBB96 

Language in 
SINUMERIK Operate 

Language code Default language Assigned project language in the TIA Portal 

1 German deu x German (Germany) 
2 French fra x French (France) 
3 English eng x English (United States) 
4 Spanish esp x Spanish (Spain) 
6 Italian ita x Italian (Italy) 
7 Dutch nld   
8 Chinese Simplified chs x Chinese (PR China) 
9 Swedish sve   
18 Hungarian hun   
19 Finnish fin   
28 Czech csy   
50 Portuguese ptb   
53 Polish plk   
55 Danish dan   
57 Russian rus   
68 Slovakian sky   
69 Slovenian slv   
72 Rumanian rom   
80 Chinese Traditional cht   
85 Korean kor   
87 Japanese jap   
89 Turkish trk   



 Configure the language settings 
 10.4 Language assignment in language-dependent texts 

SINUMERIK Integrate Create MyHMI /WinCC V13 
Configuration Manual, 02/2014 123 

Value in 
DB10.DBB96 

Language in 
SINUMERIK Operate 

Language code Default language Assigned project language in the TIA Portal 

212 Thai tha   
 Malay msl   
 Indonesian ind   
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 Loading and integrating a configuration (PC systems) 11 
11.1 Overview 

Introduction 
Once you have set the configuration and compiled it, you need to transfer it to the PCU 50.5 
and integrate it in SINUMERIK Operate. 

The following options are available: 

● Transferring the configuration outside of the TIA Portal in a conventional manner, e.g., 
with a USB flash drive or network. 

● Transferring the configuration in the TIA Portal using the command "Extended download 
to device". 
You can select the PG/PC interface USB, COM, HTTP, Ethernet or file. 

This section provides an example of the procedure when using the "Extended download to 
device" dialog with a "File" as "PG/PC Interface". 

If you transfer the configuration to the PCU 50.5 in another way, you may only need to 
integrate the Runtime in SINUMERIK Operate (Page 130) instead. 
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Precondition 
● The screen resolution is set (Page 46). 

● If the header of SINUMERIK Operate is to be displayed at runtime, the screen size is 
configured (Page 48). 

● The current status of the configuration is completely compiled. 
See: Information system, keyword "Project, compile". 

● PCU 50.5 and PG/PC are available in the network. 

You can find information about the network configuration of the PCU 50.5 Windows 7 in 
the Basic Software and HMI Software commissioning manual under PCU Basic Software 
Windows 7 (IM10). 

Procedure overview 
 
Step Description 
1 On the PCU 50.5 create the target directory for configuration as network drive. 

In so doing, note that the path to this directory must not contain any spaces. If, for example, you have installed 
SINUMERIK Operate e.g. under C:\Program Files (x86)\, you cannot save the configuration in a subdirectory of 
this. 
Additional information on network drives is available in the help for Windows 7 or in the documentation for PCU 
50.5: 
• Windows Support: Sharing files with other people (http://windows.microsoft.com/en-us/windows7/share-files-

with-someone) 
• Commissioning manual "PCU Basesoftware Windows 7", Chapter "Drives C: and D: PCU 50.5 released in the 

network for administrator accounts" 

2 Establish the connection to the configured network drive on the PG/PC. 
You can find additional information in the help for windows 7: 
• Windows Support: Create a shortcut to a network drive (mapping) (http://windows.microsoft.com/en-

us/windows7/create-a-shortcut-to-map-a-network-drive) 
Depending on the network settings, you may need to specify the same user account and password that you use 
on the PCU 50.5. 

3 Download the configuration to the PCU 50.5 (Page 127). 
4 Integrate the runtime in SINUMERIK Operate (Page 130). 

See also 
Configuring the PG/PC interface (PC systems) (Page 28) 

http://windows.microsoft.com/en-us/windows7/share-files-with-someone
http://windows.microsoft.com/en-us/windows7/share-files-with-someone
http://windows.microsoft.com/en-us/windows7/create-a-shortcut-to-map-a-network-drive
http://windows.microsoft.com/en-us/windows7/create-a-shortcut-to-map-a-network-drive
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11.2 Loading configuration to a PCU 50.5 

Requirement 
● The screen resolution is set (Page 46). 

● The configuration is compiled. 
See: Information system, keyword "Project, compile". 

● The destination directory on the PCU 50.5 is displayed as network drive on the PG/PC. 
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Procedure 
To load the project files to the PCU 50.5 via the TIA Portal, follow these steps: 

1. Select the PC system in the project tree and select "Download to device > Software (all)" 
from the shortcut menu. 
The "Extended download to device" dialog opens. 

 
Figure 11-1 "Extended download to device" dialog with settings for loading to PCU 50.5 

2. Make the following settings: 

 

Area Setting 
PG/PC interface type File 
PG/PC interface File system 
Target path The drive letter of the newly-created drive on 

the configuration PC. 



 Loading and integrating a configuration (PC systems) 
 11.3 Integrating Runtime in SINUMERIK Operate (PC systems) 

SINUMERIK Integrate Create MyHMI /WinCC V13 
Configuration Manual, 02/2014 129 

3. Click "Download". 

Result 
The project files are copied to the directory on the PCU 50.5, which you have defined as a 
network drive.  
The next task is to integrate the configuration in SINUMERIK Operate (Page 130). 

Additional information 
You can find additional information about loading projects in the information system of the 
TIA Portal, section "Visualizing processes> Compiling and downloading > Loading projects". 
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11.3 Integrating Runtime in SINUMERIK Operate (PC systems) 
You use the "Integration SINUMERIK Operate" tool to integrate the "WinCC RT Advanced" 
Runtime in SINUMERIK Operate. You can make various settings in the corresponding 
dialog, for example, you can specify the softkey via which the Runtime of SINUMERIK 
Operate is available. 

The tool is installed on the PCU 50.5 by the setup program for SINUMERIK Integrate Create 
MyHMI /WinCC. "WinCC RT Advanced" Runtime supplied on the product DVD must be 
installed beforehand for this purpose. 

See: Installing software on the PC system (PCU 50.5) (Page 26) 

Requirement 
● The operating system of the PC system is Windows 7. 

● The following software is installed on the PC system: 

– "WinCC RT Advanced" Runtime supplied on the product DVD is installed. 

See Installing software on the PC system (PCU 50.5) (Page 26). 

– SINUMERIK Integrate Create MyHMI /WinCC is installed. 

See Installing software on the PC system (PCU 50.5) (Page 26). 

– SINUMERIK Operate is installed. 

● The configuration file "pdata.fwc" can be accessed from the PC system and the path to 
this file does not contain spaces. 
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Procedure 
To integrate the Runtime in SINUMERIK Operate, follow these steps: 

1. On the PC system (e.g. PCU 50.5), click in the Windows Start menu on "Start > 
Siemens Automation > SINUMERIK > Integration Sinumerik Operate English Tool". 

The "Integration SINUMERIK Operate" dialog opens. 

 
Figure 11-2 Example of a completed "Integration SINUMERIK Operate" dialog 

2. Make the required settings: 

 

No
. 

Array Definition/Action 

① Softkey position The drop-down list shows the currently free, assignable horizontal 
softkeys. Select an available softkey (default softkey = 7). 

② Project file The TIA Portal configuration file of the WinCC RT Advanced can be 
entered by means of the input box. The configuration file is displayed with 
the "Browse" button. 
The path to the "pdata.fwc"project file may not contain any spaces. 

③ WinCC RT as 
power up 
application 

Here you specify if the WinCC Runtime application covers up 
SINUMERIK Operate when it starts up. 
• NO: SINUMERIK Operate is not covered. 
• YES: SINUMERIK Operate is covered. 
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No
. 

Array Definition/Action 

④ SINUMERIK HMI 
header visible 

Here you can define whether the header of SINUMERIK Operate (display 
of the operating area, operating mode, alarms, etc.) is to be visible for the 
WinCC application. 
• NO: Header is not visible. 
• YES: Header is visible. 
If YES is entered here, the location of the header on the configuration 
interface of each WinCC screen must be kept free for this. See: 
Configuration of the screen size (PC systems) (Page 48) 

⑤ Load WinCC RT 
during power up 

Specifies if the application is started in the background during power up 
of SINUMERIK Operate. 
• NO: Application is not started. 
• YES: Application is started. 

⑥ These system 
keys are only 
processed by 
WinCC RT 

Here you can define whether/which keys are to be provided directly to the 
application. The selected system keys are not processed by SINUMERIK 
Operate. 
• Alarm acknowledgement: ESC is directly assigned to the application 
• Channel switching: F11 is directly assigned to the application 

⑦ Softkey visible 
as of access 
level 

Use the drop-down menu to specify as of which access level the softkey 
is visible. 

⑧ Language/softke
y text 

The softkey labeling for the respective language can be entered in the 
input boxes under softkey text.  

3. Confirm the settings with "Exit". 

A dialog for prompting saving appears. 

– Select "Yes" to save all entries and the dialog box is exited. 

– Select "No" and the dialog box is exited without saving the entries. 

– Select "Cancel" to cancel the close process and return to the integration tool. 

Result 
Runtime is integrated according to your settings in SINUMERIK Operate. 

You usually need to integrate Runtime in SINUMERIK Operate only once. You only need to 
repeat the process if you want to change something in the settings for the integration of 
Runtime in SINUMERIK Operate (e.g. the softkey position). 

If you change the configuration, although you need to save the latest compiled configuration 
file again at the configured location, Runtime does not need to be integrated into 
SINUMERIK Operate again. 
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 Appendix A 
A.1 SINUMERIK functions, which can be triggered using certain events 

of the WinCC RT Advanced 

Introduction 
The following tables list the functions for the relevant WinCC objects and their associated 
events that are used for SINUMERIK with SIMATIC Panels. These functions are indicated by 
a crpss in the table.  

In the following five tables, these are the WinCC objects 

● Tags 

● Function keys 

● Buttons 

● Screen 

● Alarms 

● OCX 

● Script 

● Scheduler 

SINUMERIK functions, which can be triggered using certain events of the WinCC RT Advanced, part 
1 
 
Object Variables Softkey 

Global Local 
Event Value 

changed 
Upper limit 
exceeded 

Lower limit 
fallen below 

Release Press Release Press 

Functions        
SetS7OperatingMode X X X X X X X 
AcknowledgeNCCancelAlar
ms 

X X X X X X X 

LogonNC X X X X X X X 
LogoffNC X X X X X X X 
ChangeNCPassword X X X X X X X 
SetNCUserFrame X X X X X X X 
SelectNCPartProgram X X X X X X X 
PrepareActualNCBlockForD
isplay 
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Object Variables Softkey 
Global Local 

Event Value 
changed 

Upper limit 
exceeded 

Lower limit 
fallen below 

Release Press Release Press 

Functions        
StartNCPIService X X X X X X X 
ResetNC X X X X X X X 
ConfigureNCMachineData X X X X X X X 
ScreenObjectCursorUp       X X X X 
ScreenObjectCursorDown       X X X X 
ScreenObjectPageUp       X X X X 
ScreenObjectPageDown       X X X X 
PartProgramListSelectNCP
artProgram 

      X X X X 

PartProgramListDirUp       X X X X 
PartProgramListDirDown       X X X X 
PartProgramListRefresh       X X X X 

SINUMERIK functions, which can be triggered using certain events of the WinCC RT Advanced, part 
2 
 
Object Command buttons 
 Global Local 
Event Release Press Release Press 
Function     
SetS7OperatingMode X X X X 
AcknowledgeNCCancelAlarms X X X X 
LogonNC X X X X 
LogoffNC X X X X 
ChangeNCPassword X X X X 
SetNCUserFrame X X X X 
SelectNCPartProgram X X X X 
StartNCPIService X X X X 
ResetNC X X X X 
ConfigureNCMachineData X X X X 
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SINUMERIK functions, which can be triggered using certain events of the WinCC RT Advanced, part 
3 
 
Object Screen Messages 

Alarm Event 
Events Loaded Cleared Activate Clear Acknowledge Edit Activate Clear Edit 
Functions          
LogonNC X X               
LogoffNC X X               
ChangeNCPassword X X               
SetNCUserFrame X X X X X X X X X 
SelectNCPartProgra
m 

X X X X X X X X X 

PrepareActualNCBlo
ckForDisplay 

X                 

StartNCPIService X X X X X X X X X 
ResetNC X X X X X X X X X 
ConfigureNCMachin
eData 

X X X X X X X X X 

ScreenObjectCursor
Up 

X X               

ScreenObjectCursor
Down 

X X               

ScreenObjectPageU
p 

X X               

ScreenObjectPageD
own 

X X               

PartProgramListSele
ctNCPartProgram 

X X               

PartProgramListDirU
p 

X X               

PartProgramListDirD
own 

X X               

PartProgramListRefr
esh 

X X               
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SINUMERIK functions, which can be triggered using certain events of the WinCC RT Advanced, part 
4 
 
Objects OCX Script 

OCX (ScreenItem) InScripts 
Event Press, Release, Click, 

Change (or Toggle when 
used on a Switch), 
SwitchOn, SwitchOff 

Activate Deactivate  

Functions     
SetS7OperatingMode X X X X 
AcknowledgeNCCancelAlarms X X X X 
LogonNC X X X X 
LogoffNC X X X X 
ChangeNCPassword X X X X 
SetNCUserFrame X X X X 
SelectNCPartProgram X X X X 
PrepareActualNCBlockForDisplay         
StartNCPIService X X X X 
ResetNC X X X X 
ConfigureNCMachineData X X X X 
ScreenObjectCursorUp X X X   
ScreenObjectCursorDown X X X   
ScreenObjectPageUp X X X   
ScreenObjectPageDown X X X   
PartProgramListSelectNCPartProgram X X X   
PartProgramListDirUp X X X   
PartProgramListDirDown X X X   
PartProgramListRefresh X X X   

SINUMERIK functions, which can be triggered using certain events of the WinCC RT Advanced, part 
5 
 
Object Scheduler 
Event ExpireTime ScreenChange ChangeUser AlarmOverflowBuffer StartUp ShutDo

wn 
Function       
LogoffNC     X     X 
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A 
Activate 

Project language, 118 
Address multiplexing, 78 
Alarm 

Acknowledge, 113 
Alarm text, 82 
Configuring, 80, 86 
Directory, 82 

C 
Change language, 119 
Communication 

Communication channel, 57, 61 
Communication drivers, 30 
Communication parameters, 58 
Communication principle, 16 

Configuration 
Alarm, 80, 86 
Operating area, 42 

Connection,  
Connections selection field, 101 
HMI connection, 54 

Cycle, 108 

D 
Disabling 

Project language, 118 
Display object 

Changing during Runtime, 102 
NC part program, 98 
NC parts program, 100 

E 
Editor 

Address editor, 66 
Alarms, 80 
Connections, 54, 58 
Display objects, 100, 109 
Messages, 86 
NC Editor, 30 

Screens, 98 
Example project, 21 

F 
File 

Project file, 131 
Flashing, 101 

H 
HMI device 

Panel, 33, 49 
PC, 32, 41, 57 
Resolution, 46 

I 
I/O field, 21, 77 
Interface 

Ethernet, 58 

K 
Key switch, 111, 132 

L 
Language 

Activate project language, 118 
Change language, 32 
Disabling the project language, 118 

License 
Logs, 22 
Recipes, 22 
SIMATIC CE HIM devices, 23 
SINUMERIK Operate GUI, 22 
WinCC Powertag license, 22 
WinCC Runtime Advanced 128 PowerTags V12, 22 

M 
Migrating, 30 
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N 
NC 

Part program, 115 
Password, 111 
Restart, 112 
Traversing program, 107 

O 
Operating area 

Supplement, 39 
Operating mode, 109 

P 
Password 

Changing, 111 
Reset, 111 

Project language 
Activate, 118 
Disabling, 118 

Properties 
NC parts program, 100 

R 
Runtime 

Change language, 119 
Runtime systems, 41 
Software, 44 
WinCC RT Advanced, 42 

S 
Screen resolution, 46 
SINUMERIK Operate 

Change language, 119 
Sinumerik Operate Integration, 15 

Softkey 
Horizontal softkeys, 131 

Software 
Integration SINUMERIK Operate, 130 

Startup, 131 

T 
Tag 

Address multiplexing, 78 
Convert, 15, 35 

GUD, 15 
GUD tag, 66 
Local tag, 107 
NC tag, 61, 63, 107 
OPI tag,  

TIA Portal 
Download mechanism, 126 
Migrating, 30 

Traversing block, 107 

U 
User interface 

WinCC RT Advanced, 39 

Z 
Zero offset, 113 
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